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Conventions and Features Used in This Book
This book uses special text and design conventions to make it easer for you to find the 
information you need.

Text Conventions

Convention Feature

Abbreviated menu 
commands

For your convenience, this book uses abbreviated menu commands. 
For example, “Choose Tools, Forms, Design A Form” means that you 
should click the Tools menu, point to Forms, and select the Design A 
Form command.

Boldface type Boldface type is used to indicate text that you enter or type.

Initial Capital 
Letters

The first letters of the names of menus, dialog boxes, dialog box 
elements, and commands are capitalized. Example: The Save As 
dialog box.

Italicized type Italicized type is used to indicate new terms.

Plus sign (+) in text Keyboard shortcuts are indicated by a plus sign (+) separating two 
key names. For example, Shift+F9 means that you press the Shift 
and F9 keys at the same time.

Design Conventions

Note
Notes offer additional information related to the task being discussed.

Cross-references point you to other locations in the book that offer additional information on 
the topic being discussed.

Caution!
Cautions identify potential problems that you should look out for when you’re com-

pleting a task, or problems that you must address before you can complete a task.
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INSIDE OUT � This Statement Illustrates an Example of an “Inside Out” 
Problem Statement

These are the book’s signature tips. In these tips, you’ll get the straight scoop on what’s 

going on with the software—inside information on why a feature works the way it 

does. You’ll also find handy workarounds to different software problems.

Troubleshooting
This statement illustrates an example of a “Troubleshooting” problem 
statement.

Look for these sidebars to find solutions to common problems you might encounter. 

Troubleshooting sidebars appear next to related information in the chapters. You can 

also use the Troubleshooting Topics index at the back of the book to look up problems 

by topic.

Sidebar

The sidebars sprinkled throughout these chapters provide ancillary information on 

the topic being discussed. Go to sidebars to learn more about the technology or a 

feature.
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Introduction
Maybe you’ve noticed: creating simple documents today is so 2009. In this new decade, 
the emphasis has shifted from designing, creating, editing, and printing real hold-in-your-
hands documents to creating content that can be used in a variety of smart, efficient ways. 
You might create content about a new product, for example, and instead of simply print-
ing a fact sheet that you hand to all your sales reps, you save one version as a PDF, send 
another in an e-mail message, post some of the content to a blog, include some of the 
description in a catalog, and forward the Word file to peers around the globe.

What’s more, you’ll rarely create these content pieces alone. The use of teams is growing 
throughout industries of all types, and with good reason. When you work collaboratively, 
each person on a team can contribute his or her expertise, without tying up anybody’s time 
around the clock. Shared review enables many people with many perspectives to provide 
feedback so the content is the best that it can be. Team work, when it works well, can make 
a huge difference in the type and quality of materials you create. When team work doesn’t 
work well, of course, it’s another story. Luckily, Word 2010 includes some great new features 
that help you to reduce or dissolve collaboration challenges.

Another big change in the way we work has brought about changes in Word 2010. Today, 
thanks to the advent of the mobile phone and the wanderlust spirit of today’s information 
enthusiast, we know it’s possible—and we increasingly want—to work anywhere, anytime. 
You know those moments that seem wasted on the train out of the city? Now you can use 
them to finish reviewing a document you need to share with your team in the morning. 
You can access your Word files—and edit, format, review, and share in real time—from any 
point you have Web or smartphone access.

With these major changes in the way we work and where we work underway, Word 2010 
is positioned to be a state-of-the-art word processing program that really is there for you. 
With the tools you need to produce any kind of content you want and the flexibility to 
enable you to create, edit, and share that content from almost any point on the globe, 
Word 2010 pops the lid on anything that was holding you and your creativity back before.

Get Busy with Word 2010
With all that being said, the book you now hold in your hands is a major revamp from pre-
vious versions of Microsoft Word Inside Out. As Word users, our need for content creation 
has been kicked up a few notches, and this book responds accordingly. In the pages that 
follow, you’ll find that the emphasis on creating all kinds of content, with anyone, from 
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anywhere, flows through the examples, features, and projects. We hope you’ll find examples 
that speak to the way you use Word every day to accomplish the goals of your business, 
department, company, or school.

The various parts and chapters in this book help you to explore the whole Word 2010 land-
scape from a variety of entrance points. The parts focus generally on the types of overall 
tasks you are likely to want to complete, and individual chapters within each part zoom in 
on a specific tool or technique (or range of techniques) related to that task. Along the way, 
you’ll find notes, Inside Out tips, and troubleshooting ideas, as well as some “green” ideas 
and sidebars offering additional information that can help boost your understand or appli-
cation of Word 2010 concepts.

Some Assumptions About You
The Inside Out series is designed for readers who have some experience with Word and are 
pretty comfortable finding their way around the program. You don’t have to be a power 
user or Word developer by any means; you aren’t necessarily a technology enthusiast (like 
your author) although you do like the idea of using programs in a way that is efficient and 
effective so you can accomplish what you want to accomplish without a lot of fuss and 
bother.

For this reason, Microsoft Word 2010 Inside Out touches only briefly on some of the basic 
topics that you’ll find covered in more detail elsewhere. Although we want the coverage in 
a book this size to be as complete as possible (we want you to get what you paid for), we 
also focus in on techniques and topics that are likely to appeal to readers who have already 
mastered many of the basics in Word.

If you find that you’d like to brush up on Word 2010 basics in addition to taking on the 
topics you’ll find covered fully in this book, you may want to check out any or all of the fol-
lowing books:

•	 Microsoft Word 2010 Plain & Simple, by yours truly (Microsoft Press, 2010)

•	 Microsoft Word 2010 Step by Step, by Joyce Cox and Joan Preppernau (Microsoft 
Press, 2010)

Tip
Remember that although nothing replaces the book experience when you need to 

refer to a technique or look something up in a reference work, there are other learn-

ing opportunities available to you online. Visit Microsoft Learning for online learning 

courses related to Word 2010 and the other Office 2010 programs.
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About This Book
Microsoft Word 2010 Inside Out helps you learn to master Word 2010 in the way you’re 
most likely to use the program, following a linear process that looks something like this:

•	 Create a new document

•	 Apply a template and make layout choices

•	 Choose your theme for color and style

•	 Add content

•	 Translate phrases and documents

•	 Edit your content and use reference tools

•	 Apply and customize Quick Styles

•	 Add tables, diagrams, art, and more

•	 Co-author and share your documents with your team, near and far

•	 Work almost anywhere with the Office Word Web App

•	 Use Word 2010 for special projects, like blogging, mailings, long documents, and 
more

•	 Tackle the high-end Word features, including macros and forms 

Each chapter provides the detail you need to know in order to accomplish those various 
tasks successfully, and you’ll find tips and cautions along the way to steer you away from 
trouble spots and help you optimize the time you spend creating content.

How This Book Is Organized
Microsoft Word 2010 Inside Out gives you a comprehensive look at the various features you 
will use whether you create long or short projects for print or online uses. The chapters are 
organized according to the types of tasks you are likely to be performing. Here’s the gen-
eral roadmap for the book: 

Part I, “Word 2010: Make an Immediate Impact,” starts with the obvious: the way the world 
has changed in relation to technology and the way we work, and how that is reflected in 
the new features you’ll find in Word 2010. After a tour of the new features, you explore 
Backstage view and find out about the best ways to create a new document, apply and 
tweak a template, set up a page, adjust a layout, and apply themes.
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Part II, “Creating Global Content: From Research to Review,” focuses on the ways you pull 
together different elements to create your Word document, translate it for a global audi-
ence, and edit, proof, and use reference tools as you polish up your words. In this part, you 
also learn the ins and outs of Quick Styles and find out how to create them on your own. 
You use the new Navigation Pane to find just what you want when you want it, reorganize 
content with Outline view, and spend a little time with the streamlined print process.

Part III, “Make Your Point Visually,” shines a light on one of the big improvements in Word 
2010. As it becomes easier to grab and insert photos in our documents and content pieces, 
the overall look of the files we create is improving. Today you can create a professional mar-
keting piece in under an hour that used to take weeks (no kidding) at a commercial print 
shop. Not only are the cost and quality under your control, but the images you choose to 
portray and the styles and artistic effects that you select enable your content to rival that 
produced by expensive firms or elaborate marketing departments. Also in this part, you 
learn how to add screenshots to your content and reflow text around the art elements on 
your pages.

Part IV, “Word 2010 as a Team Effort—Anywhere, Always,” helps you tackle the challenge of 
creating content in a global workplace that likely needs that content to be produced in dif-
ferent ways for different audiences. The reality of localizing content is that programs need 
to include translation tools that are easy to use and extend—and Word 2010 has just those 
sorts of translation tools. With the new language features in Word 2010, you can choose 
from a variety of languages and set up multiple levels of control for translations, whether 
you want to translate entire documents, sections, or words and phrases on the fly.

Part V, “Word 2010 Interactive,” moves things to a new level as you consider the differ-
ent ways you can share the content you create. Whether you are generating an enormous 
master document that combines subdocuments contributed by a number of team mem-
bers; blogging for a global audience; or designing and completing mass mailings to your 
customer base, donor list, or parent population; you’ll find what you need to complete your 
projects in this part of the book. This part also includes more specialized high-end Word 
2010 techniques related to designing and distributing documents that use content controls 
and automating tasks using macros.

Getting Started
So as you can see, there’s a lot to cover no matter how you plan to produce and offer your 
Word 2010 content to the world. The great news is that Word 2010 is in sync with the times 
and can grow right along with you as you stretch your own capabilities to master the fea-
tures you need. The next chapter gets you started on that path by introducing you to the 
new and improved features in Word 2010.

MSWord_IO.indb   30 9/21/10   2:47 PM



1

Part 1

Word 2010: Make an 
Immediate Impact

Chapter 1

Spotlight on Microsoft Word 2010 .  .  .  .  .  .  .  .  .  .  3

Chapter 2

Managing Your Documents with 
Backstage View .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 33

Chapter 3

Right Now Document Design 
with Word 2010  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 69

Chapter 4

Templates and Themes for a 
Professional Look .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 101

Chapter 5

Customizing Page Setup and 
Controlling Pagination  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 139

Chapter 6

Setting Up Your Layout with Page 
Backgrounds and Columns .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 173

MSWord_IO.indb   1 9/21/10   2:47 PM



MSWord_IO.indb   2 9/21/10   2:47 PM



3

Chapter 1

Spotlight on Microsoft Word 2010

Imagining Word 2010. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  3

What’s New in Word 2010?. . . . . . . . . . . . . . . . . . . . . . . . . .  4

Finding Your Way Around the Word 2010 Window. .  .  .  . 13

Understanding and Tailoring the Status Bar . .  .  .  .  .  .  .  .  .  . 30

What’s Next?. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 31

For most of us, the phrase word processing doesn’t bring to mind exciting images of 
movement, color, sound, and images. It doesn’t promise a lot of fun and connection 
like the phrase social networking does. It doesn’t hint at an unlimited world of informa-

tion or draw you closer to what fascinates you like the phrase web browsing does.

But that’s all changing with Microsoft Word 2010.

The newest version of Word offers new and improved features that make it easy for you 
to make your documents look better than ever. You can control the format, enhance your 
text, and apply artistic filters to images to make your documents really shine. You can easily 
translate content on the fly, access your documents from almost anywhere, blog and share 
content with social media sites, and share your content with colleagues in a number of 
different formats with just a few clicks of the mouse. And you can access your content in 
a variety of ways—from the server, your desktop PC, your smartphone, or any device with 
Web access.

This chapter encourages you to envision the types of projects you’d like to create with Word 
2010 and spotlights the new and improved features that will help get you there. Along 
the way, you’ll learn about the Word 2010 window, explore the Ribbon, and find out more 
about Word options, the Trust Center, and tweaking program features to your liking.

Imagining Word 2010
So how will you use Word 2010? Maybe one of the following scenarios fits what you have 
in mind or reflects tasks you might want to try in the future:

•	 Create a four-color annual report with photos of your staff, services, and office.

•	 Design a new product brochure with high-quality typography.

•	 Download the latest version of a document from shared server space so that you can 
review, edit, and upload the content later.
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•	 Draft a letter to your top-level donors.

•	 Post an entry to your blog.

•	 Edit a book chapter simultaneously with others on your team.

•	 Review and edit your document while you’re on the road.

The content you create today is likely to be much different from the ho-hum documents 
you drafted, printed, and photocopied a dozen years ago. Thanks to the advent of Web and 
mobile technologies, change is happening at an ever-increasing rate, and it’s touching the 
way we create, edit, and share our information—printed and otherwise. Yesterday you were 
working on documents, one at a time, using revision marks and then waiting for your docu-
ments to come back from review. To move a file from one computer to another, you either 
e-mailed it or saved it to a disk or USB drive. 

As today’s Word user, you are probably not tied to a single computer as you create, edit, 
review, and share the content you create. You might use one computer at home and 
another at work; perhaps you check e-mail on your smartphone and log in to the office 
server from remote places that offer Web access. No longer are you working on one docu-
ment at a time and then sending it to another member of your team for review—now your 
group might be viewing, editing, discussing, and commenting on the document in real 
time. And nobody is stuck at a stand-alone or networked PC any longer; now editing on 
your smartphone is a real option, as is logging in to your files using the Word Web App.

The idea is to give you a consistent user experience with Word 2010 no matter which 
device you might be using. Whether you open and work with files on the Web, review con-
tent on your smartphone, or edit documents on your PC, you’ll be able to access and lever-
age the content you create in an almost unlimited number of ways.

What’s New in Word 2010?
Word 2010 is an exciting new release because not only have software developers been 
listening to the requests and feedback of users like you all over the globe, but they have 
also taken into account the way the work world is changing. With Word 2010, you can take 
advantage of features that enable you to share files in real time, work seamlessly with your 
corporate server, edit content simultaneously, and dramatically improve the pictures and 
the look of your text.

MSWord_IO.indb   4 9/21/10   2:47 PM



C
h

ap
te

r 
1

	 What’s New in Word 2010?	 5

The changes in Word 2010 offer new and improved features in three key areas:

•	 Creating a better user experience.  The Ribbon—which was introduced with Word 
2007—can now be fully customized, which means that you can create your own tabs 
and tab groups. And now Backstage view brings together all the tools you need to 
set program preferences, work with files, and protect and share your content. Other 
user experience enhancements include the Navigation pane, which enhances the 
power of your search capabilities, and Paste with Live Preview, which enables you to 
preview various paste options before you add content to your document.

•	 Improvements in authoring.  Co-authoring, also known as simultaneous editing, 
is the big story in authoring features for Word 2010, but you’ll also find great new 
image features and text effects that help your content really stand out. What’s more, 
now you can use high-end typographic features through the OpenType fonts that 
support them, including ligatures, kerning, stylistic sets, and more.

•	 Word power in new contexts.  The idea of taking Word beyond the desktop 
becomes reality in Word 2010. Now you can move from desktop to Web to smart-
phone to server—and back again—using any of the various access choices for Word 
2010. You can also run Word 2010 on 64-bit systems to take advantage of the full 
processing power your computer possesses.

The sections that follow give you a quick introduction to each of these features in more 
detail.

Enhancing Your User Experience

Word 2010 is all about flexibility—putting more power in your hands and giving you the 
tools to tailor the program to work the way you do. These are some of the top enhance-
ments that will make your user experience a more pleasant one in Word 2010:

•	 Customizable Ribbon.  You can easily add your own tabs and tab groups to the 
Ribbon in Word 2010. Suppose that you regularly create reports introducing the new 
products your company introduces. You can add tab groups that give you easy access 
to the tools you use for preparing, formatting, and reviewing the documents you are 
charged with producing (see Figure 1-1).
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Figure 1-1  You can easily customize the Word 2010 Ribbon to add tabs and tab groups 
(as demonstrated on the Share tab in this image) that fit the way you use the program.

For specific steps on tailoring the Ribbon to include the tools and tabs you want, see 
Chapter 2, “Managing Your Documents with Backstage View..

•	 Navigation pane.  The Navigation pane combines the best of the Find tool with 
Outline view and thumbnail displays, giving you three different ways to navigate 
the content in your document. You can search by heading, by thumbnail, or by text 
phrase. Additionally, you can use Word’s Find and Replace tools from the Navigation 
pane and browse through the objects in your document as well.

•	 Paste with Live Preview.  Word users copy, cut, and paste information all the 
time. In fact, Word users undo paste operations more than any other—at least in 
part because in previous versions of the program, you didn’t always get the results 
you expected when you pasted information. Whether you are copying and pasting 
text, pictures, objects, headings, lines, charts, diagrams, or shapes, you need to make 
choices about the way in which you want the information pasted into your docu-
ment. The new Paste with Live Preview makes it possible for you to preview the way 
the information will look before you click to paste it in your document. This builds 
more flexibility into a very common task, saving you time and trouble by enabling 
you to paste the information the way you want it—the first time.
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•	 Backstage view.  In Backstage view you have access to all the tools you’ll use to 
create, save, open, share, protect, and print the files you create. Backstage view sim-
plifies many of the most common file management tasks and gives you access to 
program information, Word Options, and Help choices (see Figure 1-2).

Figure 1-2  Backstage view pulls together all the tools you need to work with files and 
program preferences.

Better Authoring Features

Many different features in Word 2010 are designed to improve your authoring experience 
so that you can create content that accomplishes the goal you’re reaching for. Some of the 
top authoring features include:

•	 Co-authoring in real time.  Word 2010 lets more than one person work in a file 
at the same time. You can communicate with other authors as you work and easily 
see where changes are being made in the document (see Figure 1-3). What’s more, 
the co-authoring feature helps you resolve any editing conflicts that might arise (for 
example, perhaps you and a co-author have edited the same paragraph in different 
ways and Word can help you resolve the issue). 
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Chapter 22, “Collaborating and Co-Authoring in Real Time,” shows you the ins and outs 
of co‑authoring and walks you through the process of resolving authoring conflicts in 
your files.

Figure 1-3  When you use Word 2010’s co-authoring feature, you can see when and where 
others are making changes in a shared file.

•	 Better translation tools help you talk to the world.  With Word 2010, you can 
choose the language you want to use for a number of translation and on-screen 
features. You can customize help text and program prompts, or translate text, sec-
tions, or entire documents on the fly using the Mini Translator (see Figure 1-4), the 
Research task pane, or whole-document translation services.

You learn how to set up the language you want to use and choose your translation 
preferences in Chapter 9, “Translating Text and Working with Languages.”
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Figure 1-4  The Mini Translator pops up over your Word window and enables you to copy, 
look up, or listen to the translation.

•	 Check what you mean—as well as what you say.  The new contextual spelling 
checker helps you check your document for errors in usage as well as spelling. Did 
you say “there” when you meant to say “their”? Or did you use “loose” instead of 
“lose”? The new contextual spelling checker points out these and other errors so that 
you can make sure your document is as grammatically accurate as possible.

•	 Improve pictures with artistic effects and enhanced editing.  Word 2010 now 
includes specialized filters that you can apply to the images you place in your docu-
ments. Instead of including a regular photo of a new product, for example (although 
you might want to include that elsewhere in your document), you can stylize the 
image by applying one of any number of cool effects, such as glass, pencil sketch, 
plastic wrap, and more (see Figure 1-5). You can also control the balance, saturation, 
contrast, and more in your photos by using the expanded editing capabilities—you 
can even remove the picture background, which you’ll learn more about in Chapter 17, 
“Adding and Editing Pictures and Screenshots.”
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Figure 1-5  With Artistic Effects, you can apply high-end graphics filters to images in your 
documents.

Tip
Word 2010 also includes enhancements to SmartArt. Find out about SmartArt’s 

new features in Chapter 16, “Create Compelling SmartArt Diagrams and Charts.”

•	 Show others your screen.  If you create training materials or want to share a pic-
ture of what you see on-screen, you’ll enjoy the new Insert Screenshot feature in 
Word 2010. As part of the Illustrations group, you can either grab a portion of the 
screen or insert an entire screen image in your current document. You’ll find out 
more about adding screenshots in Chapter 17.

•	 Enhance text with text effects and support for OpenType features.  New text 
features in Word 2010 enable you to apply new effects to the content and headings 
in your document, such as glows, reflections, 3-D effects, and much more. You can 
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also take advantage of high-end typography features available with some OpenType 
fonts, including ligatures, stylistic sets, and number styles to extend the look you want 
to create.

Chapter 7, “Creating and Reusing Content,” introduces you to the ways that you can 
use text effects to spruce up the look of your text and increase your font choices with 
OpenType support.

Tip
Expanded inking capabilities. Word 2010 now includes improved support for ink users 

via an expanded pen palette, enhanced touch sensitivity, and the ability to incorporate 

and convert inked content to digitized text and equations. Turn to Chapter 7 for more 

information on using ink capabilities in Word 2010. 

Use Word 2010 Anywhere

When was the last time you sat at your desk all day long and worked on one continuous 
document? We thought so. Word 2010 takes into account the needs of today’s user, who is 
often on the go, juggling multiple projects, and working seamlessly with others down the 
hall or around the world. New features that help you take Word 2010 beyond your desktop 
PC include:

•	 The Word Web App.  Now you can access your Word 2010 files and review, edit, 
update, format, and share them normally from any point where you have Web access. 
Using your SharePoint Workspace or Windows Live SkyDrive account, you can access 
your saved files and work with them in a Web version of the Word 2010 interface 
you’re accustomed to (see Figure 1-6). This means you don’t need to carry a flash 
drive or e-mail documents to yourself in order to access them in different places.

•	 Seamless saving to the server.  Working with others means that you might be reg-
ularly saving the files you create in a shared server space or posting your documents 
to Windows Live SkyDrive so that others can access them. You can save your files to 
your shared space as easily as you save a document on your hard drive in the office. 
Another detail, simplified.
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Figure 1-6  The Word Web App makes it easy for you to work on your files from any point 
you have Web access.

•	 Using Word Mobile 2010.  In addition to having the flexibility to work on your 
Word files from the Web or saving to your server, you can also access and work with 
your files from your smartphone. Using a streamlined Microsoft Office 2010 interface 
designed for the small screen, you can view, edit, format, update, and share your 
documents easily from your phone.

Note
Office Mobile 2010 is not part of the Office 2010 suites and must be purchased 

separately. 
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Finding Your Way Around the Word 2010 Window
It turns out that we’re still dealing with the aftermath of the Office 2007 user interface 
redesign. People had greatly divergent views on the overall approach that the designers 
of Office 2007 were reaching for—and many people just plain didn’t like the Ribbon. Early 
reactions were generally positive—people were intrigued by the idea that Office designers 
went “back to the drawing board” when they began brainstorming about the new look and 
feel of the user interface. Experienced users were wary—why fix what’s not broken?—and 
power users wondered whether the simplified design would make it impossible to use the 
shortcuts, macros, and more they had come to rely on to expedite their document tasks.

Word 2010 (along with all the other Office 2010 applications) carries forward the purpose 
and intent of the new user interface, this time offering increased flexibility—now you can 
customize the Ribbon to suit your needs. Shortcut keys still work, macros are easier to 
create than ever, and we realize—as the software continues to move forward—that we 
haven’t lost any of the familiar tools that we were worried about misplacing in the new 
design. 

Get What You Need, Intuitively

But, you know, everybody’s different. One of the lessons I think Word 2007 taught was that 
not everybody was in agreement that “new = better.” The intention to create an interface 
that was easier to use and ultimately uncluttered the workspace was a good one. And the 
design philosophy behind the Ribbon—bringing you just the tools you need when you 
need them, organized around specific tasks you want to complete—was also sound. But 
learning a dramatically new interface and getting comfortable finding your favorite tools 
and options when you need to get things done can be a bit of a headache—one many 
Word users suffered through on the way to a more intuitive word processing experience.

When you open Word 2010 for the first time, the screen that meets your eye is open and 
inviting. Figure 1-7 shows the Word 2010 window. The Ribbon appears at the top of the 
screen, with tabs that group the tools you need for the various tasks you’ll undertake in 
Word.
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Quick Access
Toolbar

Tabs

Status Bar View Controls

Tab Group The Ribbon

Dialog
Launcher

Work Area

Figure 1-7  The Word 2010 window.

Exploring the Ribbon

The Ribbon across the top of the window organizes the tools in tabs, which reflect the dif-
ferent tasks you are likely to want to accomplish with the program. For example, when you 
create the document, the Home tab provides the commands you are likely to use as you 
start out. When you want to add pictures, shapes, diagrams, and more, you find the tools 
you need on the Insert tab. When you’re ready to share your document with others, the 
Review tab offers a variety of tools for preparing the file for review and working with 
the review copies when you receive them. 

The Ribbon, as it appears by default, includes all the following elements:

•	 Tabs (Home, Insert, Page Layout, References, Mailings, Review, and View).  Tabs 
stretch across the screen just below the window’s title bar. You can also customize the 
Ribbon by adding tabs and tab groups that provide tools you use most often.

•	 Groups.  These are collections of tools available on the Ribbon when a specific tab 
is selected. For example, on the Insert tab, the groups displayed include Pages, Tables, 
Illustrations, Links, Header & Footer, Text, and Symbols. 

MSWord_IO.indb   14 9/21/10   2:47 PM



C
h

ap
te

r 
1

	 Finding Your Way Around the Word 2010 Window	 15

•	 Contextual tabs.  Contextual tabs help keep the window uncluttered by displaying 
task-related tools only when an object is selected in the document. When you select 
a picture, for example, the contextual Picture Tools tab appears along the top of the 
Ribbon. The commands displayed when the tab is selected all relate to the object 
you’ve selected (see Figure 1-8).

Figure 1-8  Contextual tabs display tools related to the specific object you select in the 
document. 

Note
The Ribbon is fully displayed by default when you begin working with Word. If you 

want to minimize the Ribbon to increase room on the screen, press Ctrl+F1 or click the 

Minimize The Ribbon button, located to the left of the Help tool just above and at 

the right end of the Ribbon. The Ribbon reduces to the tabs only. To redisplay the Rib-

bon, press Ctrl+F1 again or click Expand The Ribbon. A quick way to reduce and alter-

nately display the tabs is to double-click one of the tabs. The first double-click hides 

the Ribbon; the second redisplays it. 
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You can tailor the Word 2010 interface to fit your own style. Now you can add tab groups, 
create new groups, reorder tools, and rename groups already displayed. You’ll find everything 
you need to make these changes in Word Options. See Chapter 2 to find out the specifics.

Keep Your Favorite Tools in Reach with the Quick 
Access Toolbar

In the upper-left corner of the screen you’ll find the Quick Access Toolbar, which offers, 
within clicking distance, favorite file-management tools you are likely to use often. When 
you first launch Word 2010, the Save, Undo Typing, and Repeat Typing tools appear in the 
Quick Access Toolbar. You can click the Customize The Quick Access Toolbar arrow to dis-
play a list of additional tools and options that you can use to tailor the tools offered there 
(see Figure 1-9).

Figure 1-9  You can tailor the Quick Access Toolbar to include the tools you use often and want 
to make available while you work.

You can customize the Quick Access Toolbar a couple of different ways. First, you can sim-
ply click the tool you want from the Customize Quick Access Toolbar list. If the tool doesn’t 
appear in the list, you can click More Commands, navigate to the tool you want to add, and 
click it. You can also add a tool to the Quick Access Toolbar by right-clicking the tool in the 
Ribbon, and then click Add To Quick Access Toolbar (see Figure 1-10).

Tip
The changes you make to the Quick Access Toolbar in one document carry through for 

other documents as well. To return the Quick Access Toolbar to the default display, click 

the Customize Quick Access Toolbar and choose More Commands. In the Customiza-

tions area, click the Reset arrow and choose Reset Only Quick Access Toolbar, and then 

click OK.

MSWord_IO.indb   16 9/21/10   2:47 PM



C
h

ap
te

r 
1

	 Finding Your Way Around the Word 2010 Window	 17

Figure 1-10  Add favorite tools to the Quick Access Toolbar easily.

Note
If you add a number of tools to the Quick Access Toolbar, you might want to give 

it more room by displaying the toolbar in its own row below the Ribbon. To do so, 

Right-click anywhere on the Ribbon and choose Show Quick Access Toolbar Below The 

Ribbon. To return the display of the toolbar to its original state, right-click the Quick 

Access Toolbar and choose Show Quick Access Toolbar Above The Ribbon.

Using Dialog Launchers

The Ribbon is great for providing you with groups of tools that are related to the task 
you’re trying to accomplish, but sometimes it’s helpful to see all the options you have avail-
able so you can make the best choice. In those situations, having a traditional-style dialog 
box comes in handy. Dialog boxes are available for some groups on the Ribbon. Those 
groups that do have a dialog box display a small, boxed arrow symbol, called a dialog 
launcher, in the lower-right corner of the group. For example, the Font group on the Home 
tab has a dialog launcher in the lower-right corner. When you click the launcher, the dialog 
box appears (Figure 1-11).
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Figure 1-11  Dialog launchers display dialog boxes.

Options for displaying dialog boxes are also available at the bottom of any gallery that 
offers additional options. For example, when you click Columns in the Page Setup group on 
the Page Layout tab, a gallery of column settings appears. Click the More Columns option 
(see Figure 1-12) at the bottom of the gallery to launch the Columns dialog box.

Figure 1-12  Click the More Columns command at the bottom of the gallery to display 
additional options.
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Working with Galleries

Word 2010 includes all sorts of galleries—themes, styles, picture styles, and more—that 
graphically display the range of choices from which you can click the design, color, layout, 
and style you want. You will see galleries displayed in different ways, depending on your 
screen resolution and the size of the Word window. The Ribbon was designed to adjust to 
the size of the screen, so in some cases you might see galleries appear as selections on the 
Ribbon, while other galleries appear as drop-down items.

Basically you’ll see galleries presented in one of three ways in Word. Some galleries are 
shown as part of a group on the Ribbon (similar to the Picture Styles gallery shown in 
Figure 1-13); you can click the More button in the lower-right corner of the gallery to 
display the full collection of choices. Other galleries (such as those available for Themes, 
Margins, and Position commands) display as drop-down galleries from which you can 
make your selection.

Figure 1-13  Some galleries display choices in the Ribbon.

Other galleries open as a palette of choices, like the Corrections gallery shown in Figure 
1-14. Using galleries, you can easily see at a glance which color combination, format, color 
scheme, transition, or chart type you want. The choices you see in the galleries are con-
nected with the theme you’ve selected (if any) for your document. This helps you be sure 
that when you’re choosing a chart type, for example, it reflects the colors, fonts, and effects 
used in other parts of your document.

To choose an option in a gallery, simply click your choice, and the setting is applied to the 
current document or selected object.
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Figure 1-14  Some galleries open as palettes from which you can easily click your choice.

Tip
You can easily preview how the new selection will look by hovering your mouse over 

the option you’re thinking about selecting. The effect of the choice will show in the 

selected object or text in your document. In this way, you can try out different choices 

before you commit to one by clicking it.

Making Quick Formatting Changes with the Mini Toolbar

If you’re like other Word users, many of the choices you make while you’re working on a 
document have to do with formatting. Word 2010 includes the Mini Toolbar to bring the 
most common formatting options to you so you don’t have to leave your creative zone to 
choose the options you want to apply. Whenever you select text, the Mini Toolbar appears 
above the selection (see Figure 1-15). If you want to use the Mini Toolbar, move the mouse 
toward it and select the option you want; otherwise, move the mouse pointer away from 
the toolbar and it will fade away.
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Figure 1-15  The Mini Toolbar displays quick formatting choices whenever you select text.

Note
If you find the Mini Toolbar distracting or don’t think you’ll use it, you can simply turn 

the feature off. On the File tab, choose Options; in the General tab of the Word Options 

dialog box, clear the Show Mini Toolbar On Selection check box, and then click OK. 

Now the Mini Toolbar is disabled and will not appear the next time you select text. (It 

will appear, however, when you right-click selected text.) To reactivate the Mini Toolbar, 

display the Word Options dialog box again and reselect the check box.

Getting a New View of Your Document

While you’re working on your document, you can easily change to a different view by click-
ing one of the view tools in the bottom-right corner of the Word window or by choosing a 
view in the Document Views group on the View tab. You can also use the new Zoom slider 
(in the lower-right corner of the Word window) to enlarge or reduce the display of the 
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document. Word offers you many different ways to view your work, depending on the type 
of document you’re creating and the task at hand:

•	 Print Layout  This view, which is used by default when you create a new document, 
seems to be the view most people use as they create and edit their documents. It 
shows how the document will look when printed. In this view, you can see headers 
and footers as well as footnotes and endnotes. The edges of the page and the space 
between pages are also visible as you type and edit.

Tip
You can alternately suppress and display the top and bottom margins of your 

document in Page Layout view by double-clicking the space between the pages. 

By default, Page Layout view shows a gap between pages. If you position the 

pointer over the page break, the pointer changes to two arrows and a tooltip 

prompts you to double-click the space to remove it. Double-clicking at that 

point removes the space between the pages and enables you to view text before 

and after the break in a continuous paragraph. To return the page display to the 

default setting, position the pointer over the page break line and double-click.

•	 Full Screen Reading  This view gives you the maximum amount of space on the 
screen, giving you more room to review and comment on the content. Note, how-
ever, that Full Screen Reading view does not display the document as it will look in 
print—that’s the job of Page Layout view. By default, when you first begin using Full 
Screen Reading view, the functionality is limited to only reviewing and commenting. If 
you want to be able to type and edit in Full Screen Reading view, click View Options 
in the upper-right corner of Full Screen Reading view and choose Allow Typing.
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Figure 1-16  Using Full Screen Reading view, you can view, comment on, and edit your 
document with a maximum amount of room on the screen.

•	 Web Layout  This view displays the page as though it were a Web page. The first 
thing you will notice when you select the Web Layout view tool is that the page mar-
gins are not used, and depending on the content of your document, the format of 
your document might seem skewed (see Figure 1-17). 
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Figure 1-17  Web Layout view shows you what your document will look like as a Web 
page.

•	 Outline  With this view, you can see the document in outline form, with headings 
and subordinate text indented so that you can easily identify and work with sections 
in a long document.

•	 Draft  This view is a fast, no-frills mode that many people prefer to use when they 
need to write or edit something quickly. Note that some elements—such as headers 
and footers—are not visible while you’re working in Draft view.

Finding What You Need Quickly with the Navigation Pane

An exciting new feature in Word 2010 combines the Document Map and Thumbnail fea-
tures with a powerful search tool to help you to find content you need quickly using what-
ever method works best for you. On the View tab, select the Navigation Pane checkbox in 
the Show group; the Navigation pane appears on the left side of your Word 2010 window 
(see Figure 1-18).
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Figure 1-18  The Navigation pane enables you to view, move through, and search your 
document by heading, page view, or text search.

The Navigation pane offers three different tabs that move you through the information in 
your document by one of these methods:

•	 Browse the headings in your document.  When you click this tab (shown in Fig-
ure 1-18), Word 2010 displays a list of headings in your document. Clicking on any 
of these heading will bring you directly to the point in the file where the heading 
appears.

•	 Browse the pages in your document.  This tab displays thumbnail images of the 
pages in your document. Again, you can move to a specific page by clicking on an 
image in this view.

•	 Browse the results from your current search.  This tab shows the results of a 
search performed using a word or text phrase you enter in the Search Document box. 
The results are listed and highlighted, as shown in Figure 1-19. Move to the result in 
the file by clicking the result you want to see.
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Figure 1-19  You can search for text in your document, and the Navigation pane shows 
you every place the word or phrase appears.

Tip
You can also search for specific objects in your document using the Browse Object 

features. For more about searching and navigating your document, see Chapter 8, 

“Navigating Your Document.”

Displaying Rulers and Gridlines

When you are working on a document in which the alignment and sizing of elements is 
important, you will want to turn on rulers and gridlines to ensure that items line up on the 
page and meet the measurements you need. The controls for both items are found in the 
Show/Hide group on the View tab.

You can display and hide rulers quickly using a tool located at the top of the vertical scroll-
bar. The rulers are displayed by default, so to hide the them, click the View Ruler button. To 
redisplay the rulers, click the tool a second time.
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Alternatively, you can display vertical and horizontal rulers by selecting the Ruler check box 
on the View tab. To hide the rulers, clear the Ruler check box.

Adding gridlines is a similar process. On the View tab, select the Gridlines check box. Grid-
lines appear on your document to which you can easily align pictures, quotes, or other ele-
ments on your page (see Figure 1-20). 

Figure 1-20  Gridlines help you to align pictures, charts, and other elements in your document.

Note
If you don’t like rulers cluttering up your work area and you want to remove the verti-

cal ruler in Print Layout view, you can turn it off using Word Options. On the File tab, 

choose Options, and then choose Advanced and scroll down to the Display options. 

Clear the check box for Show Vertical Ruler In Page Layout View. Click OK to save your 

changes. When you return to Print Layout view, the vertical ruler will be gone.
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Viewing More Than One Page at a Time

The Zoom group on the View tab includes five different tools with which you can change 
the size and number of pages you view on the screen at any one time. Page Width view is 
selected by default, but you can easily change the view to match your own comfort level. 

To change the size of the text, click the Zoom tool to open the Zoom dialog box. You can 
choose one of the preset sizes or specify your own by clicking in the Percent box and typ-
ing a new value (see Figure 1-21). You can also change the number of pages displayed by 
choosing the Many Pages option and then dragging to select the number of pages you 
want to display on the screen. The Preview window shows you how your document will 
look, and the sample text area shows how readable (or not!) your text will be. When you’ve 
made changes you are happy with, click OK to save them.

Figure 1-21  Use the Zoom dialog box to change the way your document is displayed.

In addition to changing the page display in the Zoom dialog box, you can also easily switch 
among multipage views by clicking the One Page, Two Pages, or Page Width tools in the 
Zoom group on the View tab. Each of these tools behaves the way you would expect—One 
Page shows you the whole page at the cursor position; Two Pages displays the page on 
which the cursor is active and the next full page in the document; and Page Width magni-
fies or reduces the size of the document so that it fits the width of the Word window.

Working with Multiple Documents

When you are working on a big project, chances are that you will have more than one doc-
ument open at the same time. If you’re copying and pasting your research notes into a new 
journal article you’re writing, or if you’re incorporating the latest fundraising figures into 
the annual report, you’ll need an easy way of moving among open documents while you 
work. The View tab includes the Window group which gives you the means to do just that.
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When you want to easily move among open Word documents, use the Switch Windows 
tool. When you click Switch Windows, a list appears that shows you the various open win-
dows (see Figure 1-22); just click the one you want to see.

Figure 1-22  Click Switch Windows and choose the document you want to view to move 
among open files.

Use the New Windows tool when you want to open a new copy of the current document 
in a new window. You might use this tool when you need to edit or compare different por-
tions of a large document instead of endlessly scrolling back and forth. When you’re ready 
to close the copy, click the close button in the upper-right corner of the screen.

The Arrange All, Split, and View Side By Side commands all enable you to choose how you 
want to view the open documents. If you have more than two documents open at once, 
clicking View Side By Side displays the Compare Side By Side dialog box, as shown in the 
following image. Here, you can choose the other open document you want to compare 
with the current one. Select your choice and click OK to display the document.

Note
Depending on the number of open document windows and your screen resolution, 

when you use the Arrange All command, the Ribbon might disappear. This happens 

due to the auto scale feature of the Ribbon. To return to the full view of the Ribbon, 

simply resize the height of the document window.
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When you use the View Side By Side command, Word sets the default to Synchronous Scroll-
ing, which means that as you scroll through one document, the other document scrolls 
automatically as well. This is helpful for comparing documents in which you’re looking for 
paragraphs, sections, or even phrases that might be slightly different.

Understanding and Tailoring the Status Bar 
The status bar, which is located in the lower-left corner of the Word 2010 window, provides 
useful information about your current document. By default, the status bar shows you: 

•	 The location of the cursor position

•	 The number of pages in the document

•	 The number of words

•	 Whether any proofing errors exist

•	 The selected language you are using if you have installed more than one language 
keyboard preference

Note
You might also see in the status bar an indicator that lets you know whether any macros 

are currently being recorded in your document.

The status bar includes four key elements:

•	 The Page area shows the number of the current page and the length of your docu-
ment. You can also click this area to display the Go To tab in the Find and Replace 
dialog box.

•	 Word displays a continually updating word count on the status bar as well. If you 
select text, Word shows you how many words of the total word count are selected 
(for example, 50/451). Click this area to display the Word Count dialog box, in which 
you can view additional statistics on number of characters, paragraphs, and more.

•	 To detect errors, an ongoing spelling and grammar checker continuously reviews your 
document content. Click this icon to go to the error and see options for correcting it.
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•	 If you have installed more than one language and keyboard preference for your 
version of Word 2010, the language you have selected as the default appears in 
the status bar to the right of the proofing indicator. Click this option to display the 
Language dialog box and choose the language used for the spelling and grammar 
checker. 

In addition to the controls that show in the status bar by default, you can add or remove 
options by right-clicking anywhere on the bar. The Customize Status Bar list appears, 
presenting statistics about your document and showing you which features are currently 
enabled (see Figure 1-23). Additionally, the Customize Status Bar list provides the status 
of various elements that show you the status of the file; for example, in Figure 1-23, you 
can see that there is no macro currently being recorded and that Permissions and Track 
Changes are both turned off for the current file.

Figure 1-23  The Customize Status Bar list displays the status of various features in your 
document and enables you to add or remove additional options.

What’s Next?
This chapter introduced you to some of the leading new features in Word 2010, so now you 
can begin to experiment with the program, whether you want to make good documents 
look great, share your content easily with colleagues, or access your files from the Web. The 
next chapter introduces you to Backstage view, where you can manage your files and pro-
gram information in one convenient place in Word 2010.
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D epending on the nature of the document you’re creating, it might be important to 
both show and tell readers the points you most want them to remember. You can 
illustrate your most important ideas—showcasing comparisons, depicting processes, 

and portraying important relationships among departments, vendors, sales data, and more. 
And in addition to the functional nature of the illustrations you can add in Word 2010, they 
just look nice; they add color, special effects, dimension, and more to your two-dimensional 
page.

In this chapter you learn about SmartArt, the diagramming tool that is included as part of 
Word 2010, and find out how to add and enhance charts in your Word document. What’s 
more, the charts you add interact easily with Excel 2010, so you can use simple worksheet 
sections or complex calculations as part of the charts you create.

Adding SmartArt Diagrams
The name SmartArt says much about the functionality of this feature, which was first made 
available in Word 2007. SmartArt enables you to diagram your ideas easily—in a wide 
variety of ways—and enhance those diagrams by adding special effects, such as shadows, 
3-D effects, styles, color schemes, and more. 

SmartArt simplifies the process of creating diagrams of all sorts. When you need to create 
any kind of diagram that illustrates a process, a workflow, a listing, or the way things work 
together, you can do it quickly with just a few clicks of the mouse using SmartArt.

SmartArt is an interactive diagramming tool that is a dramatic improvement over the dia-
gram feature available in versions prior to Word 2007. With earlier tools, you were limited 
to six diagram types, and your formatting options were also limited. With SmartArt, you can 
choose from a large collection of diagram styles, customize them to your heart’s content, 
and include your own pictures within the body of the diagram. What’s more, you can apply 
a variety of design styles to add depth, shadow, shine, and perspective.
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Creating the SmartArt Diagram

When you’re in the document, begin by positioning the cursor where you want the dia-
gram to appear. Then on the Insert tab, in the Illustrations group, click SmartArt. The 
Choose A SmartArt Graphic dialog box appears, as shown in Figure 16-1.

Figure 16-1  Start your SmartArt graphic by choosing the type of diagram you want to create.

The Choose A SmartArt Graphic dialog box presents several different types of diagrams 
from which you can choose, each designed to convey a specific type of information.

•	 A list diagram displays a nonsequential series of items. You might use a list diagram 
to introduce a series of new products in your spring catalog.

•	 A process diagram can show a step-by-step process. For example, you might use a 
process diagram to show a new trainee how to log on to your computer system.

•	 A cycle diagram can show the workflow of a particular operation, typically something 
that is repeated in a cyclical process.

•	 A hierarchy diagram shows levels, so it is a logical candidate for organization charts. 

•	 A relationship diagram shows how various items relate to each other. You might use 
a relationship diagram, for example, to show how different roles in a volunteer work 
group complement each other to provide specific services to the organization.

•	 A matrix diagram is helpful when you want to compare four items in a format that 
is easy for viewers to understand. You might use a matrix diagram to explain the 
research focus for each quarter of the next fiscal year.
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•	 A pyramid diagram shows items in relationship that typically build from the bottom up. 
A good example of a pyramid diagram is a fundraising chart in which the bottom 
level represents the largest number of beginning level donors who contribute to the 
organization, and the top level represents the smaller percentage of major donors. 

•	 A picture diagram enables you to create a diagram in which the photos are the main 
point. You might use a picture diagram, for example, to show range of products in 
your product line and who manages the various divisions.

•	 The Office.com selection provides you with additional SmartArt choices you can use 
in a number of different diagram styles.

Begin the process of creating your SmartArt diagram by choosing the diagram type you 
want from the left panel of the Choose A SmartArt Graphic dialog box. Notice that when 
you click a diagram type, styles for that particular diagram appear in the center of the dia-
log box. Click the style you like, and you’ll see an illustration and detailed description of the 
type of diagram you’ve selected displayed on the right (see Figure 16-2). Click OK to create 
the diagram.

Figure 16-2  The SmartArt graphic style you select is displayed and described in the right side of 
the dialog box.

The diagram appears at the cursor position. Figure 16-3 shows a picture diagram as it first 
appears. Notice that SmartArt Tools contextual tabs appear automatically in the Ribbon as 
soon as you create the diagram. You will use the tools on the SmartArt Tools Design tab to 
edit and enhance the diagram by adding text boxes and pictures, changing the diagrams 
colors, and applying styles. Use the tools in the SmartArt Tools Format tab to change the 
appearance of text and shapes in the diagram.
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Figure 16-3  Use the SmartArt Tools Design tab to choose the layout, style, and color for your 
diagram.

Adding and Formatting Diagram Text 

Adding text to your diagram is simple: just click in the first text box and type the text you 
want to display in the box. Press Tab to move to the next text box. Repeat as needed until 
the text boxes are filled. If you run out of text shapes and need to add a new one, click the 
Add Shape down arrow in the Create Graphics group on the SmartArt Tools Design tab and 
choose whether you want to add a shape after, before, above, or below the current shape.

If you prefer to enter all text at once rather than clicking individual shapes and typing text 
entries, you can display the SmartArt text pane. On the SmartArt Tools Design tab, click 
Text Pane in the Create Graphic group, then in the Text Pane, click in the item you want to 
change and type your text. 

You can format the text in the diagram by highlighting the text and choosing the text 
options from the Mini Toolbar that appears above the selection. You can also apply text 
styles by highlighting the text, clicking the Format tab, and choosing the setting you want 
to apply in the WordArt Styles group. Text Effects is a new tool in Word 2010 with which 
you can apply special treatments—Shadow, Reflection, Glow, Bevel, 3-D Rotation, and 
Transform—to the text you select (see Figure 16-4).
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Figure 16-4  Change the look of your diagram text by applying styles and effects from the 
WordArt Styles group on the SmartArt Tools Format tab.

Making Formatting Changes in the Diagram

You can apply special formats to give your diagrams a professional look while carrying over 
the design of your publication in terms of color scheme, fonts, and more. Similar to the 
chart options available with traditional charting in Word, SmartArt diagrams also offer you 
a variety of layouts and styles that you can apply directly to the diagrams in your docu-
ments. To change the layout of the diagram, click it and select the Design tab on the Smart-
Art Tools contextual tab. Then click the More button in the Layouts gallery to display the 
full range of layout possibilities. Depending on the type of diagram you’ve created, you will 
see a variety of layout options. Click the one that best fits the data concepts you’re trying 
to convey.

Like other objects in Word 2010, the available formatting settings that you can apply to 
your SmartArt are influenced by the theme selected for the document. You can change the 
colors in your SmartArt diagram by selecting a preset color palette with the Change Colors 
tool, which is available in the SmartArt Styles group on the SmartArt Tools Design tab. 
When you choose Change Colors, a palette of choices appears. The colors that correspond 
to the selected theme appear in the top portion of the palette. Point to the one you want 
to preview then click your final choice to apply it to the diagram in your document.
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SmartArt Quick Styles offer you a gallery of ready-made styles (complete with 3-D settings, 
shadows, rotation, lighting, and more) that you can apply to your diagram with a click of 
the mouse. Click the More button to display all the choices and select the one you want 
(see Figure 16-5).

Figure 16-5  Choose a SmartArt Style to apply 3-D effects, lighting, and more.

Note
You might start out with rectangles in a list diagram or circles in a relationship dia-

gram, but that doesn’t mean you have to stick with those shapes. You can replace a 

traditional shape with a unique one of your choosing by selecting the traditional shape 

and clicking Change Shape in the Shapes group of the SmartArt Tools Format. Click the 

Change Shape down arrow and select a shape from the displayed list. The shape in your 

diagram is replaced with the new shape. This can be done for any part of the graphic 

that can be selected as a separate shape (for example, one rectangle in a list).
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Creative Charting
Charts can dramatically enhance the information you’re sharing with others in the docu-
ments you create. A chart can show a reader at a glance what percentage of sales a particu-
lar product comprises. A bar chart quickly shows which division is outselling all the others. 
An area chart can show the results of tracking over time. The charts you include in your 
documents give you a way to visually showcase important data that others will understand 
easily. You might use a chart to:

•	 Announce a new sales competition for your staff.

•	 Show the number of volunteers each of your regional sites has trained in the previous 
quarter using a pie chart.

•	 Show the staff how the new construction on your building is coming along by plac-
ing a bar chart over a photo of the building as it’s being constructed.

•	 Point out which sites are recruiting the greatest number of volunteers using textured 
columns.

Note
What’s the difference between a chart and a graph? Nothing, really. The terms 

are often used interchangeably to describe the graphical depiction of data—early 

on, the term charting referred to a type of mapmaking. Graphing, on the other 

hand, involved plotting data points and discerning trends and relationships. 

Today, the terms mean essentially the same thing; charts and graphs help you 

illustrate trends and relationships in your data. Diagramming usually refers to 

the process of using a specific model to generate flowcharts or diagrams. 

Introducing Word 2010 Chart Types 
Charts are often used to illustrate relationships—how one item relates to another, how an 
item this year relates to the same item last year, how a product is selling over time. Eleven 
different chart types are available:

•	 Column  A column chart is used to show data comparisons. You might show, for 
example, how two data series “stack up” against each other for the first quarter.

•	 Line  A line chart plots data points over time or by category. You might use a line 
chart to show a trend in product returns over a six-month period.
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•	 Pie  A pie chart shows the relationship of different data items to the whole. Each pie 
comprises 100 percent of the series being graphed, and each slice is shown as a per-
centage of the pie. You might use a pie chart to show the relative size of individual 
departments in the northeastern sales division of your company.

•	 Bar  Word shows a bar chart as horizontal bars, graphing data items over time (or 
other categories). You might use a bar chart to compare the stages of different prod-
ucts in a production cycle.

•	 Area  An area chart gives you the means to compare data two different ways: you 
can show the accumulated result of the data items, and you can show how the data 
(and their relationship to one another) change over time. For example, you might use 
an area chart to show how many students took each module of the exam at two dif-
ferent universities.

•	 XY (Scatter)  With an XY chart, you can plot pairs of data points over time. You 
might use an XY chart to contrast the test scores from a battery of exams given at 
two different universities.

•	 Stock  A stock chart displays four values for a single item—open, high, low, close—
and is designed to show the variance in a particular item within a specific period of 
time.

•	 Surface  A surface chart is a great way to compare the change of three data items 
over time. Through the use of colored levels, a surface chart shows in three-dimension 
form where the data in a particular series leads (see Figure 16-6).

•	 Doughnut  A doughnut chart is similar to a pie chart in that it shows the relation-
ship between data items. Doughnut charts enable you to compare two sets of data 
and the way in which they relate to the whole and to each other. You might use a 
doughnut chart to portray two different sales campaigns. The sections of the dough-
nut could represent the different sales channels, and you could compare and contrast 
the different effects of each channel.

•	 Bubble  With a bubble chart, you can plot three different data series. Each item is 
plotted at a particular point in time and shows the data value as a bubble. You can 
see, for example, which accounts had the highest charges during the second quarter.

•	 Radar  A radar chart plots multiple data points and shows their relation to a center 
point. You might use a radar chart to show how each regional sales division fared in a 
recent sales competition.
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Figure 16-6  With a surface chart, you can illustrate series data in three dimensions.

Creating a Basic Chart
The process of creating a chart in Word is simple. First click to position the cursor wherever 
you want the chart to appear (you can move the chart later if you choose) then follow 
these steps:

1.	 On the Insert tab (on the Ribbon), click Chart in the Illustrations group.

The Insert Chart dialog box appears, as shown in Figure 16-7.

Figure 16-7  The Insert Chart dialog box is where you can view and choose the type of 
chart that meets your needs.
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2.	 Choose the chart type you want to create by clicking it in the left pane of the Insert 
Chart dialog box.

The gallery area on the right shows the various styles available for the chart type you 
selected. Click OK to create the chart. 

The default chart in the type you selected appears in the document on the left side 
of the Word window; on the right side of the window, Excel displays a datasheet that 
includes placeholder data (see Figure 16-8). You can now modify the data so it is rel-
evant to your document.

3.	 Click the close box to close the datasheet, and the chart in your document is updated 
accordingly.

Figure 16-8  As soon as you create the chart, a datasheet with placeholder data appears. 
Replace the data with your own, and the chart is updated automatically.

That’s all there is to adding your first chart to a Word document. But now comes the fun 
part—enhancing the chart with the Word Chart Tools.
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Note
The gallery area of the Insert Chart dialog box contains all the chart types available to 

you, so if you prefer, you can simply use the vertical scroll bar in the dialog box to view 

all the different chart styles. That way, if you really aren’t sure what the type of chart 

you want to create is called—but you know it when you see it—you can look over all 

the styles quickly and make your selection by double-clicking it.

Changing the Chart Type

Making sure you have the right chart for the data you’re displaying is an important part 
of communicating your concepts most effectively. Some charts, such as bar and column 
charts, are best for comparing data items—for example, tracking the sales of apples com-
pared to oranges. Other charts, such as pie charts, are better for showing the relation 
of individual items to a whole—such as the fundraising totals of your two top volunteer 
groups as they compare to total fundraising dollars in August 2010. 

Word makes it simple for you to select and change chart types. Start by creating a new 
chart or by displaying the chart you’ve already created. Click the chart (if necessary) so that 
the contextual Chart Tools are displayed on the Ribbon. On the Design tab, click Change 
Chart Type in the Type group (on the far left side of the Ribbon). The Change Chart Type 
dialog box (which you saw earlier as the Insert Chart dialog box) opens, offering you the 
range of chart types that were available to you when you initially created the chart. Simply 
click the chart type you want, click OK, and Word changes the display of the chart in your 
document and modifies the datasheet if needed.

Note
If you really like the chart type you’ve selected, you can make it the default chart that is 

used automatically whenever you create a new one. Simply click Set As Default Chart in 

the Insert Chart (or Change Chart Type) dialog box. Each time you create a new chart, 

the chart type you selected will be used by default.

Creating a Chart Template

Word offers so many ways to enhance the design of your charts that you might want to 
create your own templates so the charts you create are consistent in all of your documents. 
If you work for a company that standardizes its published materials, creating and using a 
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custom template gives you the means to make your charts distinctive while keeping them 
professionally appealing and consistent with your overall brand. 

After you’ve created, enhanced, and saved your chart (which you learn how to do on page 
506), you can save it as a template. It will then be available to you in the Templates folder that 
appears in the left pane of the Insert Chart dialog box.

To create a template based on an existing chart, simply select the chart and then select 
the Design tab in the contextual Chart Tools. In the Type group, click the Save As Template 
option. In the Save Chart Template dialog box, enter a name for the new chart and click 
Save (see Figure 16-9). Word saves the chart by default in the Templates folder, making it 
available to all your other Office applications as well. The next time you open the Insert 
Chart dialog box, the template you saved will be available in the Chart Templates folder.

Figure 16-9  Save a customized chart as a template so that you can use it in other documents 
you create.

Note
If you change the theme selected for your document, any charts you create using a 

chart template will not update to reflect the new theme. To update the format of your 

chart, click the edge of the chart frame to select it, and then click Reset To Match Style 

in the Current Selection group on the Format tab of the contextual Chart Tools.
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Understanding the Chart Tools

As soon as you create a chart, Word displays the contextual Chart Tools, which offers you a 
collection of specialized tools you’ll use to design, enhance, format, and save the chart you 
create (see Figure 16-10). 

Figure 16-10  The contextual Chart Tools enable you to change the design, layout, and format of 
your chart.

The contextual Chart Tools offer three tabs with different sets of tools for different types of 
tasks.

•	 Design  With the Design tab, you can change the type of your chart, work with 
chart data, select a chart layout, and choose the style and color for the chart you 
want to create.

•	 Layout  This tab lets you focus on specific chart elements. With the Layout tools, 
you can add pictures, shapes, and more; add and format labels; modify the axes 
in the chart; add color, pictures, or 3-D effects to the background; and insert ele-
ments like trend lines, markers, and more that help readers analyze the data they 
are reviewing.
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•	 Format  The Format tab includes tools that let you enhance the look of your chart 
by choosing the size of shapes on the chart; adding shadows, fills, and outlines; 
changing the size of the chart; and selecting text wrapping and positioning options.

Throughout the rest of this chapter, you’ll learn more about when to use each of the tabs in 
Chart Tools to change, enhance, and finalize the charts in your Word documents.

Entering Chart Data
When you first create a new chart, Word inserts a default set of dummy data into the 
datasheet and displays the datasheet in Excel. You use the datasheet to enter, arrange, and 
select the data you want to include in your chart. Throughout the life of your Word docu-
ment, you can add to and update the information in the datasheet as needed, ensuring 
that your chart always stays fresh and reflects your most current data.

Note
You can choose to link or embed chart data in a Word document. If you link a chart 

in your Word document to an external source, it will be updated whenever the source 

document changes. If you embed a chart in your document, you’ll be able to edit the 

chart as you would normally, by double-clicking it in the hosting document.

You will use the Data group (available on the Chart Tools Design tab) to work with your 
chart’s datasheet (see Figure 16-11). Here’s a quick look at the tools in that group:

•	 Switch Row/Column  With this tool, you can swap rows and columns to create a 
different display of the data in your datasheet.

•	 Select Data  Displays the Select Data Source dialog box, in which you can choose 
the data range you want to use for the chart. Additionally, you can choose the series 
and category items you want to include or hide from display.

•	 Edit Data  Displays the datasheet so that you can change, add to, or delete informa-
tion on the datasheet.

Figure 16-11  Use the Data group on the Chart Tools Design tab to work with the data in your 
chart’s datasheet.
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Working with the Datasheet

Figure 16-12 shows the datasheet that appears when you create a new pie chart in Word. 
As you can see, the series names (Series 1, Series 2, and Series 3) and the category names 
are all generic. The data in the datasheet doesn’t mean anything at this point—it simply 
provides the chart engine with something to display in the sample chart.

Figure 16-12  The datasheet displays the data values and labels used to create your chart.

Note
If you close the datasheet by clicking the Excel close button, you can redisplay it while 

you edit the chart by clicking Edit Data in the Data group on the Design tab of the con-

textual Chart Tools.

The datasheet is actually an Excel worksheet, so the tools on the Ribbon might look famil-
iar to you. Changing the data in the datasheet is a simple matter of clicking in the cell you 
want to change and typing the new information. You’ll find the following items on the 
datasheet.
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•	 Categories  The items in the columns are the categories placed along the horizontal 
axis of the chart. Categories might include months, quarters, stages of a project, or 
some other unit by which the value can be measured.

•	 Data Series  The data series show the items that are being graphed, according to 
the categories selected.

•	 Values  The data entered in the cells of the datasheet are scaled against the value 
axis, which is the vertical axis.

Note
By default, the datasheet includes data used to display the chart you add to your 

page. The first thing you will most likely do when you open the datasheet will 

be to delete the existing data so that you can enter your own. You can type the 

values directly into the cells or copy and paste the information into the datasheet 

from another source. 

Changing the Data Arrangement

By default, the new Word chart displays the categories along the horizontal axis and the 
values along the vertical axis, but if you choose, you can flip that configuration to display 
your data differently.

To change the arrangement of the data in your chart, follow these steps:

1.	 Select the chart you want to change.

The Chart Tools tabs appear.

2.	 On the Design tab, in the Data group, click Switch Row/Column.

The chart is redrawn automatically.

Tip
Although you’re creating a chart for use in your Word document, you might want 

to use data from other programs to create the chart. Because the chart datasheet is 

actually an Excel worksheet, you can link to external data sources supported by Excel. 

To display your choices for using external data in your Excel datasheet, click the Data 

tab in the datasheet and choose the option in the Get External Data group that best 

reflects the type of data you want to use. For more about working with Excel 2010, 

see Microsoft Excel 2010 Inside Out, by Mark Dodge and Craig Stinson (Microsoft 

Press, 2010). 
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Editing and Enhancing Chart Information
The chart that Word 2010 adds to your document will be fairly straightforward, with-
out much formatting or color. After you create the basic chart, you can add to, edit, and 
enhance your chart in a number of different ways. Begin by clicking the chart you want to 
change; the contextual Chart Tools appears automatically along the top of the Ribbon. You 
use the Chart Tools, shown in Figure 16-13, to change the chart layout, choose a chart style 
(including colors and shadow effects), add titles and labels, change the look of the back-
ground and axes, and much more. The sections that follow show you how to add specific 
items to your charts to make them easier for readers to understand.

Figure 16-13  Use the contextual Chart Tools to edit and enhance the charts in your document.

Note
Although many of the elements you’ll find on the Chart Tools tab relate to all the dif-

ferent chart types, some controls are disabled for certain charts. For example, the tools 

in the Axes group on the Layout tab are disabled when a pie chart is selected because 

they don’t apply to that type of chart.
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Choosing a New Chart Layout

If you spend some time working on a chart and just don’t feel it portrays what you want to 
convey, you can easily switch chart types by applying a new layout to the chart. A chart lay-
out is like a template—complete with a legend style, data labels, and more—that you apply 
to the chart you’ve already created. You can choose a layout for your chart when you want 
to save yourself the time and trouble of choosing a number of chart options individually.

To apply a chart layout, click the chart to select it, and then on the Chart Tools Design tab, 
click the More button in the lower-right corner of the Chart Layouts gallery to display the 
whole collection of layouts (see Figure 16-14). Simply click the layout to apply it to your 
chart.

Figure 16-14  Use the Chart Layouts gallery to apply specific chart formats to the charts in your 
document.
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Applying a Chart Style

Word includes another design feature that makes creating a professional chart much easier. 
The Chart Style gallery includes dozens of visual styles that you can apply to a chart in your 
document. Chart Styles include:

•	 Color selection

•	 3-D effects

•	 Shadow effects

•	 Outline style and color

•	 Background effects

To apply a chart style, select the chart, and then on the Chart Tools Design tab, click the 
More button in the lower-right corner of the Chart Styles gallery and then choose the style 
you want from the displayed collection (see Figure 16-15).

Figure 16-15  The Chart Styles gallery gives your chart a professional look with the click of a 
button.
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Change Fonts with the Mini Toolbar

By now you’ve probably noticed that Word 2010 is all about context. Whatever 

project you’re working on, Word offers you just the tools you need to complete it. 

When you want to change the font used in a chart, simply highlight the text you want 

to change. The Mini Toolbar appears over the text with which you can easily choose a 

new font, change the size, make the font larger or smaller, change the color, and more. 

Simply click your choice and the text is changed. All things should be so simple.

Adding a Chart Title

Not all charts need titles, but a chart title can help readers understand the “big picture” 
you’re trying to communicate. To add a title to your chart, click Chart Title in the Labels 
group on the Layout tab of the contextual Chart Tools. In the gallery, choose whether you 
want the title to be centered on the chart or placed above the chart. (If you decide later 
that you want to move the title, you can simply drag it to the point on the chart where you 
want it to appear.) Centered Overlay Title enables the chart to be displayed at maximum 
size (which is important if you have a fairly complex chart), while Above Chart reduces the 
chart size slightly to make room for the title. Experiment with each choice to find the one 
that’s right for your chart.
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Note
Chances are that you won’t have a lot of room in your document for lengthy chart 

titles. A good title pulls out key words that reflect what the chart portrays. If you’re 

comparing volunteer recruitment methods, “Recruitment Methods Comparison” works. 

Not exciting, but accurate. If you can think of something exciting too, all the better.

Working with Axes

The axes of your chart are important in that they set up the structure for the way in which 
data is displayed. You can use two different tools in the contextual Chart Tools to work with 
axes. Both are found on the Layout tab.

If you want to instruct Word to display the title of an axis, click Axis Titles in the Labels 
group. To add an axis title to your chart, begin by clicking Axis Titles and pointing to the 
axis you want to change (Primary Horizontal Axis or Primary Vertical Axis). When you 
point to the Horizontal Axis selection, choose Show Title Below Axis to add the title text 
box to the chart. (You can click and drag the title box anywhere on the chart you’d like it 
to appear—but be sure to keep it close to the axis so your readers will understand what it 
refers to.) If you select Primary Vertical Axis, you will see three choices: Rotated Title, Verti-
cal Title, and Horizontal Title. Select your display choice, and then simply click in the text 
box and type the text for your axis title.

If you want to change the way in which information is displayed along the axis, you can 
choose Axes in the Axes group. When you click the Axes tool, a list appears, offering Pri-
mary Horizontal Axis and Primary Vertical Axis as options. Choose the axis you want to 
change, and another set of choices appears (see Figure 16-16). For the horizontal axis, your 
choices involve whether the axis runs right to left (or vice versa) and where the data labels 
appear. For the vertical axis, you can choose the value increments you want to appear on 
the axis (thousands, millions, or billions).
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Figure 16-16  Choose the axis you want to change and make your selection from the gallery.

If you want to further control the axes in your chart, you can choose More Primary Vertical 
Axis Options or More Primary Horizontal Axis Options at the bottom of each of the respec-
tive galleries. To further refine how your axes appear, you need to display the Format Axis 
dialog box, as shown in Figure 16-17. In this dialog box, you can choose the increments for 
the values on the vertical axis, set the tick mark type, and determine the placement of the 
chart floor. In the Format Axis dialog box for the horizontal axis, you can also set axis type 
and tick mark settings, and choose where the vertical axis crosses the horizontal axis. Addi-
tionally, in both dialog boxes, you can choose line color and fill, shadow, and 3-D effects for 
the axes.

Note
You will be able to choose settings for the chart floor only when you are working with 

a 3-D chart.
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Figure 16-17  You can choose additional options for the axes in your chart by using the Format 
Axis dialog box.

Note
To hide or display axis tick marks, display the Format Axis dialog box and clear or select 

the Major Tick Mark Type and Minor Tick Mark Type options, as appropriate. Click 

Close to save your settings.

Add Gridlines and Trendlines

If you’re working with complicated charts that have multiple data series, gridlines can help 
clarify the comparisons and conclusions you want readers to draw from your chart. Select 
the Gridlines tool in the Axes group on the Chart Tools Layout tab. Then click either Pri-
mary Horizontal Gridlines or Primary Vertical Gridlines. Both choices give you the option of 
selecting major gridlines, minor gridlines, or major and minor gridlines. 

Note
You can be creative with the gridlines in your chart if you want to shake things up a 

little bit. Word 2010 enables you to choose new gradients for your gridlines and add 

shadows and arrows. Simply right-click the gridline you want to change in the chart 

and select Format Gridlines. The dialog box that appears will be either Format Major 

Gridlines or Format Minor Gridlines, depending on which set of gridlines you selected.
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Choose Line Color, Line Style, Shadow, or Glow and Soft Edges in the left panel and 

then select the options you want to apply to your chart. Click Close to save your set-

tings and apply them to your chart.

Be forewarned, however: with gridlines, a little goes a long way, so be sure to add only 

what your reader needs to understand your data. Too many lines will clutter up your 

chart and make it more difficult for readers to decipher; they can even render the chart 

unreadable if there are too many too close together.

Displaying and Positioning a Legend

Word assumes that you want a legend for your chart when you first create it. If you don’t 
feel the legend is needed and want to have more space for your chart, you can remove the 
legend by clicking Legend in the Labels group on the Layout tab (available in the Chart 
Tools). When you choose None (the first option on the list), the legend is hidden. The chart 
is enlarged to fill the space the legend previously occupied.

You can also control where the legend is placed in the chart by clicking the Legend tool 
in the Labels group. A range of options appears from which you can choose, as shown in 
Figure 16-18.

Figure 16-18  With the Legend tool in the Labels group, you can control the placement of your 
chart legend.

Tip
You can further change and enhance the legend you add to your chart by clicking 

More Legend Options at the bottom of the options list that appears when you click 

Legends in the Labels group.
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Working with Data Labels

Data labels are helpful when you need to give the reader further clues about which data 
items go with which series or category. Word gives you the ability to add several different 
kinds of data labels to your charts. You might want to add percentages to pie slices, for 
example, or category labels to stacked bars. Click Data Labels in the Labels group to display 
a list of placement choices for the data labels on your chart.

By default, Word displays data values in the pie slices or bars of your chart. You can change 
the type of information displayed and add special features such as color, shadows, outlines, 
and 3-D options by choosing Data Labels in the Labels group and clicking More Data Label 
Options. In the Format Data Labels dialog box (see Figure 16-19), you can choose the label 
contents you want to display (series name, category name, value, or percentage).

Figure 16-19  Display and enhance data labels on your chart using options in the Format Data 
Labels dialog box.

Note
You can choose to display more than one type of label. For example, you might want 

to display both percentages and category names on a pie chart. If you select more than 

one label type, use a separator to distinguish the labels. Click the Separator arrow to 

display a list of choices and then click the one you want to use.

One more way to ensure that readers get the connection between your data trends and the 
categories being plotted: you can use the Legend Key feature to add small legend tags to 

MSWord_IO.indb   517 9/21/10   3:03 PM



C
h

ap
ter 16

518	 Chapter 16  Create Compelling SmartArt Diagrams and Charts

the left of each data label. Readers will be able to see at a glance which items relate to the 
categories in your chart legend. 

Note
The data labels Word uses are taken directly from your datasheet. If you want to 

change a data label on the chart, it’s best to go back to the datasheet and make the 

change there. Otherwise, the label change might not “stick,” and you might see the 

same old label displayed the next time you view your chart.

Troubleshooting
I can’t see axis titles in my chart.

If you’re having trouble seeing the axis titles along the Category and Values axes on 

your chart, the chart area might be too small to display all the chart information suc-

cessfully. Try enlarging the chart by clicking it and then dragging one of the resize 

handles outward. If that doesn’t do the trick, right-click the axis title while editing the 

chart and then choose a different font or font size on the Mini Toolbar. 

Formatting Charts
Word gives you the ability to format all the different elements included in your chart. You 
might want to change the font of a title, resize the labels, change the background color, 
change the line thickness, apply a pattern, or perform any number of other tricks—includ-
ing adding drop shadows, glow effects, or 3-D enhancements.

To choose the chart object you want to work with, click the chart, choose the Layout tab 
on the Chart Tools, and then click the Chart Elements arrow in the Current Selection group. 
A list of possible objects appears, as shown in Figure 16-20. When you click your choice, 
Word selects that item in the chart. You can then right-click the item to display a format 
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choice—for example, right-clicking a legend displays a shortcut menu including the Format 
Legend command. When you select that command, a formatting dialog box appears in 
which you can select the colors, styles, and placement for the legend.

Figure 16-20  Use the Chart Elements list to select the chart element you want to change.

The formatting commands available vary depending on the type of chart you’re creating 
and the chart element you’ve selected. You’ll see a different set of options, for example, 
when you right-click a chart axis than you will when you right-click the legend.

Changing the Format of Your Chart Elements

Word includes a Ribbon full of formatting choices that enable you to add color and texture 
to the shapes of the elements in your chart. Additionally, you can use the Format options 
to apply special effects to your text by changing color, adding mirroring, shadowing, glow 
effects, and more. Here are a few possibilities to consider as you think about the ways you 
want to enhance your chart.

•	 Do you want a border around your chart? If so, what kind? You make those choices 
on the Format tab of the Chart Tools.

•	 Do you want to choose a different color or line thickness for the border of your 
chart? Look in the Shape Styles group on the Format tab for the choices you need.

•	 Would you like to add a drop shadow to the chart? Click the Shape Effects down 
arrow, point to Shadow, and then choose the style you want.

•	 Do you want to apply a special text effect to your title or axes titles? Choose a Word-
Art style that reflects the way you want the text in your chart to appear.
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You can change each of these items by first selecting the chart you want to change and 
then by selecting the Format tab on the Chart Tools. Figure 16-21 shows the commands 
that are available when the Format tab is selected.

Figure 16-21  The Format tab includes tools for changing colors, shapes, shadows, and more in 
your charts.

Formatting Shapes

Word provides you with an almost unlimited number of ways to enhance charts in your doc-
uments. One way you can make a big visual difference is by applying formats to the shapes 
that make up the chart. For example, consider the chart title in Figure 16-22. The 3-D style 
applied to the title is one of many available in the Shape Styles gallery (on the Chart Tools 
Format tab).

Figure 16-22  You can add special styles to the shapes in your chart by using the Shape Styles 
gallery.
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Begin by selecting the object in your chart that you want to change. Anything that you can 
click qualifies—you can change the title, the label area, the individual data series, the axes, 
and more. When you select an element, Word automatically updates the Shape Styles to 
show the styles available for that chart element. You can click the More button to see the 
entire gallery of styles available for the selected element. Click your selection to apply it to 
the chart.

Adding Shadows, Glows, and More

You can make further changes to the shape you’ve selected using the additional choices in 
the Shape Styles group on the Format tab.

•	 Shape Fill  This option displays a palette in which you can change the color, gradi-
ent, pattern, or texture of the selected shape.

•	 Shape Outline  This choice includes color selections as well as line width and style 
choices that change the outline of the shape.

•	 Shape Effects  Select Shape Effects to display a gallery of style choices with which 
you can add shadows, make the shape glow, soften the edges, rotate the shape in 
3-D, and much more (see Figure 16-23).

Figure 16-23  The Shape Effects gallery gives you options to dramatically change the look 
of shapes in your chart.
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What’s Next?
This chapter showed you how the SmartArt and chart features in Word 2010 make it easy 
to create, modify, and enhance diagrams and charts in your Word documents. The next 
chapter continues this creative focus by showing you how to make the most of Word’s abil-
ity to add impact with pictures and objects. Additionally, you’ll find out how to arrange art 
objects on the page to help give your document that finished, professional look.
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building blocks for  230
Cover Page Gallery  210
creating your own  210
galleries  233

crashes, system
corrupt Normal template  108
Document Recovery task pane  53

cropping pictures  535
cross references, document

adding  326
deleting  328
error messages  328
hyperlinks as, for web pages  327
modifying, moving, and updating  327
reference types  326
relative  328

cross references, index  722
Customer Experience Improvement Program  

68
Customize Status Bar list  31
cutting, copying, and pasting

how to, including keyboard shortcuts  80
Paste with Live Preview  6
table data  474

D

data
chart data

arrangement of, changing  508
Chart Tools Design tab, working with  506
data labels, working with  517
datasheets, working with  507

entering  506
external, using  508

hidden, removing from documents  625
merge data, working with  772
table data, sorting  486

database programs, as used in mail merge  
778

date and time elements
Date Picker content control  798
how to add  228
in headers and footers  164
recording a macro to insert  816–818

Decrease Indent tool, location of  212
defaults

date and time  229
Document Defaults  388, 407, 408
document properties  44
Font Color button  222
new document  383
Quick Access Toolbar  16

delivery delay, for e-mails  661
design

assessing regularly  73
characteristics of a well-designed document  

95
features to help with, summary of  102
importance of  101
layout and design fundamentals  175–178
redesign considerations  73, 113

Developer tab, displaying  790, 814
dialog boxes, access to launchers  17
dictionaries

adding to  301
custom

accessing and modifying  301
adding dictionaries  304
adding terms to  304
creating new  303
default, choosing  305
default location of  304
disabling, removing, and deleting  306
limitations of  303
lists of terms, converting into custom  
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	 draft versions of documents	 847

dictionary  305
digital signatures and stamps

adding a stamp  631
attaching to files  48, 630
certificate authorities and security adminis-

trators, working with  629
digital IDs

creating  629
how to get  628

macros
reasons for signing  835
self-signed signatures, creating  836
third-party signatures  836
VBA projects  837

removing signatures  632
signing  628
viewing signatures  631

directory of records, from data sources  784
display options

how to change  63
mathematical equation display, controlling  

565
documents

Arrange All command  29
browsing, using the Navigation Pane  25
comparing and combining  693–697
complex documents

factors to consider  173–175
outlining, reasons for  415–417

displaying only current document styles  398
Document Defaults  388, 407–409
Document Grid

Drawing Grid, displaying  285
language settings  149
settings, specifying  284
turning feature on  284
working with  283

Document Inspector  693
Document Quick Styles, resetting  389
Document Recovery task pane  53
Documents Building Blocks folder  237
expiration dates for documents, setting  637

inspection
from the Info tab  35
quality control tools  290

length and current page, as shown in Status 
Bar  30

mail merge documents, types of  764–768
multiple, working with  28
new, creating

default Normal template  383, 389
from the New tab in Backstage view  35, 57

orientation of, changing  147, 441
planning  142–144
properties

customizing display  44
printing  451
setting, from the Info tab  35
working with, from the Info tab  38

protection  47–49
readability level  306
recent documents

locating, in Backstage view  34
options for list  35, 55

section formatting, Reveal Formatting pane  
402

short documents, page setup features for  
143

Split command  29
style changes and  383
Trusted Documents, setting up  67
views, changing  21–24
View Side By Side command  29

double spacing, setting  345
double strikethrough of text  220
doughnut charts  500
Draft document view  24
draft versions of documents

AutoRecover feature  52
Background Saves feature  52
editing and reviewing  175
recovering and deleting

from the Info tab  35
Recover Unsaved Documents feature  54
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848	 drawings

drawings
Drawing Canvas, working with  530
Drawing Grid

displaying  285
overriding  341
Snap Objects To Grid feature  555
using  531

freehand
adding text to  552
tables  468

drawing tablets  204
drop caps, creating  357
Drop-Down List content controls  797
duplicating documents, using the New  

Windows tool  29

E

Ecma Office Open XML format  103
editing tools

AutoCorrect
adding entries  309
case sensitivity and  309
changes, controlling  308
exceptions, entering  311
function of  311
options, setting  307
replacing and deleting entries  311
symbols  311

comparing and combining documents  
693–697

copying, cutting, and pasting  80
editing restrictions, applying  622–624
editing time, total  38
Edit Links To Files selection  44
formatting inconsistencies, checking for  291
grammar, checking

activating the grammar checker  295
as you type  296
Do Not Check option  297
grammar rules, setting  300–302
hiding grammar errors, when to use  296
options, configuring  298–300

macros, editing  826–830
overview  289
permissions and restricting  48, 125
preventing editing, Mark As Final  297
proofing your document

complex documents  175
flagged errors, fixing  292–294
proofreaders, necessity of  297
Spelling and Grammar dialog box  295
suppressing proofing marks  296

quality control checks  290
saving documents  91–95
simultaneous editing

co-authoring  698–700
new features for  5, 7

spelling, checking
as you type  296
contextual  291
Do Not Check option  297
error notifications  291
hide spelling errors, when to use  296
importance of  290
options, configuring  298

text selection and shortcuts for  79
undoing, redoing, and repeating  85

e-mail attachments
sharing files

delaying delivery  661
flagging messages  660
priority, setting  659
receipts, requesting  660
sending securely  658
voting buttons  662

options for  642
e-mail attachments, setting preferences for  

64
e-mail, merge to  784
embedding vs. linking objects  583
embossing text effect  220
encryption

how to  620
passwords  48, 620
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	 file sharing	 849

removing protection  621
templates  125

energy saving features  435
engraving text effect  220
envelopes, printing  456–458
equations, mathematical

building blocks for  230
calling attention to  570
creating from scratch  563
equation display, controlling  565
Equation gallery  562
Math AutoCorrect, using  568
options, setting  566
saving

to previous versions of Word  51, 562
to the Gallery  567

symbol sets and descriptions  564
errors, checking from the Status Bar  30
ESL (English as a second language)

Microsoft Research ESL Assistant  285
Excel spreadsheets, inserting into a table  470

F

fast commands
in Backstage view  34
Recent Documents, changing number of  55

faxes, sending
choosing a service  664
creating and sending  663
multiple faxes, using Mail Merge Wizard  

666
troubleshooting  665

field codes, controlling  167
File Block settings  67, 635
file extensions

of backup files  53
displaying, how to set default  113
for macro-enabled documents  813
for macro-enabled templates  813
macro-free  813

file formats
available in Word 2010  60, 94
converters for, how to locate  46, 94

for converted documents  47
for previous versions of Word  51
for templates  102

file sharing
compatibility issues  50
converters for additional file formats  94
converting from earlier versions of Word  46
via e-mail

delaying delivery  661
flagging messages  660
priority, setting  659
receipts, requesting  660
sending securely  658
voting buttons  662

via fax
choosing a service  664
creating and sending  663
multiple faxes, using Mail Merge Wizard  

666
troubleshooting  665

file validation, changing  617
Mark As Final feature  618
network locations

accessing resources in  655
creating  654
FTP sites, linking to  654
saving documents to  655

new options for, in Word 2010  644
protection, preparing  47–49
Save & Send tab in Backstage view  58
SharePoint Workspace 2010

documents, checking in and out  649
Groove workspaces  646, 648
new documents, creating  650
new workspaces, creating  646–648

with Windows Live SkyDrive  59
Windows Live SkyDrive

co-authoring in  697–701
saving to a shared space  653
setting up and using  651
sharing files  652

with Microsoft SharePoint  59
workgroup templates, using  656
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850	 file size of document, locating  38

file size of document, locating  38
fill effects

Fill Effects dialog box  181
gradients for backgrounds  180

Find and Replace
Find and Replace dialog box  253
floating objects vs. inline objects  257
formatting settings  256
search parameters  254
special characters  257–259
wildcards  255, 256

flagging e-mail messages  660
Flesch-Kincaid Grade Level scores  306
Flesch Reading Ease scores  306
folders

creating new  94
shared  647

fonts
All Caps Font effect  221
availability on your system  213
changing, using the Mini Toolbar  512
default settings  407
Font Color tools

Font Color button  222
Mini Toolbar location of  212

Font dialog box  220
Font list

how to use  213
Theme Fonts section of  214

font size
Font Size list  214
Font Size tool  212
how to specify  214
Keyboard shortcuts for  215
table Styles, troubleshooting  483

Font tool  212
OpenType fonts  216, 217
Reveal Formatting pane  402
specifying  213
themes and  89, 131, 136
troubleshooting, printing  446

footnotes and endnotes
adding  320

customizing  321
deleting  323
description of  314
Footnote and Endnote dialog box  321
inserting  321
margins and  325
moving and copying  323
separator lines, creating new  324
visible in which views  322
on web pages, as hyperlinks  323
when to use  320

formatting text
additional formats  220
as you work  210–212
clearing formatting  223
comparing text formats  403
for complex documents  174
default settings  407
effects, deleting  220
finding instances of  256
Format Painter tool, location of  212
formatting lost, when saving to previous 

version of Word  51
formatting marks, controlling the display of  

473
inconsistencies, tracking  404
in index entries  722
quick, using the Mini Toolbar  20
resricting and protecting  125
styles, how to inspect  400
text attributes, applying  215
text effects, applying  219
using the Font dialog box  220

form controls  789
FTP sites, linking to  654
Full Screen Reading document view  22, 64
functions in tables, working with  490
fundraising materials, ideas for  240

G

galleries
building blocks  230, 232, 235, 237
custom building blocks  241
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	 Home tab	 851

custom galleries and the AutoText gallery  
242

dialog box launchers, access to  18
Equations gallery  567
Header, Footer, and Page Number  163
previewing choices  20
Quick Parts  235
Styles  381
Table of Contents gallery  707
Text Box gallery  572
Theme Colors gallery  135
Theme Effects gallery  133
themes and  130
Themes gallery, how to find  87
working with, options for  19

geometry symbol set  564
glow styles for text, applying  219
Go To command  259
grade level scores, for document readability  

306
gradients, for backgrounds  181
grammar check

activating the grammar checker  295
as you type  296
contextual spelling feature  9
Do Not Check option  297
grammar rules, setting  300–302
options, configuring  297–299
other languages  270
Status Bar, checking from  30

grant proposals, page setup features for  145
Greek letters symbol set  564
gridlines

adding, in charts  515
how to display and hide  26

Groove workspaces  646, 648
groups

in Backstage view  36
objects, grouping and ungrouping  555
types of, on the Ribbon  14

Grow Font tool
Mini Toolbar location of  212
for text size adjustment  214

gutter settings
for bound documents  147
customizing  145

H

handwritten content  78, 204
headers and footers

alignment tabs  158
building blocks  230
creating  158
deleting  158
editing  158
field codes  158
galleries  158
Go To  164
themes, changing to match fonts and colors  

158
viewing  158

headings
browsing, in the Navigation Pane  25, 248
built-in styles for  706
in Outline View  418
styles, keyboard shortcuts to apply  409
and the table of contents  706

Help
finding Help, summary of  60
Help tab in Backstage view

information available  36
Word version and product ID  37

hidden data, removing from documents  625
hidden text, how to create  220
highlighting text

hide and show highlighting  222
how to  221

Home tab
Clipboard group  84
Font group

Clear Formatting command  223, 393
Font Color arrow  222
fonts and sizes, specifying  213
Font Size list  214
text effects, applying  218
Text Highlight Color command  221
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852	 Home tab, continued

Home tab, continued
formatting commands  211
Styles group

formatting lists and text  380
Styles gallery  381
Styles Pane  390, 391

text alignment commands  224
hyphenation

automatic  355
manual  356
non-breaking

formatting  356
how to insert  227

options for  354
text in other languages  355

I

ID (product), how to locate  37
importing documents  204
Increase Indent tool, location of  212
indenting

changing  372, 441
first line and hanging indents  341
Indents and Spacing tab  342
left and right, adjusting  340
types of  350

indexes
cross-references, adding  722
entries, AutoMarking with a concordance file  

728
entries, formatting  722
entries, marking  719
formatting the index

alignment  725
columns  726
indented or run in  725
options, formatting  724

generating the index  723
good indexes, qualities of  717
long entries, and bookmarks  721
page ranges, specifying  722
repeated entries, selecting  721

reviewing your document  723
subentries, creating  720
troubleshooting, error messages  726
updating or adding entries  727

InfoPath Forms vs. Word Content Controls  
791

Info tab in Backstage view
co-authors, adding and contacting  42
document compatibility

checking and preparing for  50
Compatibility Mode  46

document properties  37, 44
Help tab  61
options  35
Permissions, setting  48–50
Recover Unsaved Documents feature  54
Related Files area  44
tags and comments, adding  39–42

ink
adding content longhand  204
expanded capabilities of  11

Insert tab
building blocks  230
Quick Tables  233
Symbols group and list  224
Text group

Date and Time tool  228
Quick Parts  231
Text From File command  77

inspection, document
for sensitive information, hidden comments, 

and XML data  50
from the Info tab  35

international mail codes and formatting  776
italics

Home tab command and keyboard shortcut  
216

how to apply  215
Italic tool, location of  212

J

justified alignment of text  224
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	 lines, horizontal	 853

K

keyboards
adding, for other languages  271
current configuration, checking  274
setting up, using current language  269
Windows Keyboard Layouts tool  271
Word Options  271

keyboard shortcuts
Apply Styles Pane  390
assigning your own

printing list of  452
symbols  226

Building Blocks, inserting existing  233
built-in commands, viewing  834
character formatting  257
copying, cutting, and pasting  81
macros  822
navigation through documents  265–266
Open dialog box  76
overriding  823
paragraph align and formatting tools  339
Reveal Formatting pane  401
styles

applying styles  409
creating your own shortcuts  410
Style Inspector  401
Styles Pane  390, 391

symbols, inserting  225
text alignment  224
text attributes and effects  216
text case, Change Case options  221
text selection  80
text sizing, incremental  215
Undo  85

keywords, for indexing your document  717

L

labels, data  517
labels, printing  458
languages

adding  269
Asian  286
automatic detection of  271

bidirectional text, using  282
changing

as you type  273
from the Status Bar  31
from Word Options  63

Document Grid, working with East Asian 
languages

drawing grids, displaying  285
locating  283
settings, specifying  284

keyboards, adding  271
proofing language, setting  270
translating

custom translations  281
definitions, real-time  276
documents  278
Microsoft Engkoo  286
Microsoft Research ESL Assistant  285
Mini Translator, using  274–276
selected text  277
tools, improvements in  274
Translation Services, changing and adding  

279–282
WordLingo service  278

Windows Language Bar  273, 274
layering of objects, controlling  556
layout, displaying Layout Options  186
left alignment of text  224
Legacy Form controls  789
legends, displaying and positioning  516
letterhead, designing  97
letter-like symbols set  564
letters, page setup features for  143
ligatures

definition  216
using  217

line and page breaks, controlling  353
line charts  499
line numbers

adding and controlling  170
adjusting while previewing  441

lines, horizontal
adding to documents  601, 603
graphical lines, creating  604
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854	 line spacing, specifying  345

line spacing, specifying  345
linked styles  382
linking vs. embedding objects  583
lists

automatic, controlling  361
bulleted lists

bullet font, changing  365
Bullet Library  364
bullet symbols, changing  366
converting to numbered list  371
custom bullets  364
new bullet, choosing  364
picture bullets  367
when to use  359

content controls, adding to  803
creating

ending a list  363
quick, from existing text  361
space between items, adding  363
while you type  362

formatting problems  363, 373
indents, changing  372
list styles

displaying  380, 392
legal style numbering  377
new, creating  375–378
paragraph formatting in  383
using for complex numbering  370

multilevel  373–375
numbered lists

converting to bulleted list  371
numbering, continuing  370
numbering, restarting  371
numbering schemes, choosing  368
style, modifying  368
when to use  360

Reveal Formatting pane  402
Live Preview, setting preferences for  64
Locations, Trusted

description of  634
specifying  66

locking content controls  803
long documents

building block ideas for  241

column layouts, switching between  195
complex documents, what to consider  

173–175
features of  732
master documents

creating  740
getting started with  738
problems and workarounds  737
subdocuments, creating  741
tools for  739
when to use  736
working with  742–744

planning  143
table of authorities

citations, adding manually  734
generating  736

table of figures
captions, adding  732
figure numbering, controlling  733
generating  734

tips for  207, 208
lowercase text, changing  220

M

Mac and PC compatibility  39
macros

Code group on the Developer tab  791
digitally signing

reasons for  835
self-signed signatures, creating  836
third-party signatures  836
VBA projects  837

disabling  815
editing

examples  826–828
Visual Basic Editor  829

lost or disabled macros, troubleshooting  
823

macro-enabled and macro-free documents, 
file extensions  47

options, additional
deleting and exporting  832
importing  833
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	 master documents  206	 855

renaming macros, modules, or projects  
830

password protecting  835
recording

examples  816–818, 824
naming  816, 834
one-click method  817
pause recording  817
setup and planning  814–816
storing  817
testing  817
troubleshooting  826

resources for further learning  839
running

“Ambiguous name detected” error  831
automatically  824–827
keyboard shortcuts, assigning  822
Macro Security settings, checking  814
Quick Access Toolbar, adding to  818
troubleshooting  823, 831
ways to use  818

saving macro-enabled documents and  
templates  813

security settings for  67, 635
and VBA, explanation of  812
when to use  811, 821

mail merge
directories, creating  784
envelopes and labels, creating  785–787
Mail Merge Wizard  763
merge fields

address blocks, adding  775
greeting lines, choosing  776
inserting  777
matching with database  778
tips for  780
types of  774
word fields, adding  780

merging the documents
print options, choosing  783
to a new document  783
to e-mail  784

overview of  762

planning your project
document type, selecting  764
existing documents, using  767
main document, current document as  765
templates, using  766
types of projects  763

postal codes and formatting  776
previewing the merge

errors, checking for  782
Preview Results group, using  781
specific entries, finding  782

recipients
choosing and sorting information  771
creating a new list  768–770
existing lists, using  770
filtering lists  773
merge data, working with  772
New Address List dialog box  769
Outlook contacts, choosing  771

terms, understanding  763
Mail Merge Wizard  666
margins, document

adjusting
changing margin settings  145
on the Ruler  146
suppressing top and bottom margins  22, 

145
while previewing  441

aligning content vertically between  145
binding documents, and  145
custom, creating  145
Margins gallery  145, 146
Margins tab  145
measurements units, changing the default  

145
Mirror Margins  151
multiple pages, settings for  151
white space, showing  145

marketing materials, ideas for  240
markup features  670–672
master documents  206

creating  740
getting started with  738
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856	 master documents, continued

master documents, continued
problems and workarounds  737
subdocuments

collapsing  743
converting  744
creating  741
expanding and displaying  743
importing data for  741
merging  744
separating  744

tools for  739
when to use  736
working with  742–744

merging table cells  477
Message Bar, settings for  67, 635
Microsoft Developers Network website  839
Microsoft Engkoo  286
Microsoft Exchange, co-authors online  43
Microsoft Genuine Advantage

downloading templates  72
Microsoft InfoPath 2010  791
Microsoft Office Help  61
Microsoft Outlook  771
Microsoft Research ESL Assistant  285
Microsoft support, contacting  61
Microsoft Translation  279
Mini Toolbar

enabling  212
formatting choices, quick  20
text selection and formatting  212
turning off and on  21

Mini Translator tool
setting preferences for  64
using  274–277

modules
deleting and exporting  832
importing  833
the Organizer  833
renaming  830

Multilevel Lists
applying  373
creating a new list style  375–378
list styles  383, 392

multiple documents, working with  28
multiple page settings  150

N

name and initials in files, setting preferences 
for  64

navigation, document
bookmarks  260
Browse Object tool  252
Find and Replace dialog box

floating objects vs. inline objects  257
formatting settings  256
Go To tab  259
special characters  257
text strings  253–256

keyboard shortcuts and function keys  
264–266

Navigation Pane
browsing by headings  248
browsing by page  249
browsing by search results  251
content, ways to find  246–251
how to use  24
search box  247
vs. Outline View  433
ways to use  6, 248

overview of, in Word 2010  245
windows, displaying and arranging

commands, locating  262
multiple windows, switching among  264
splitting the document window  262
viewing pages side by side  263

Zoom tools  261
negated relations symbol sets  564
nested tables  471
network locations, and file sharing

accessing resources  655
creating a network location  654
FTP sites, linking to  654
saving documents to  655

Newsletters, designing  99
New tab in Backstage view

new files, starting  57
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options for  35
templates, working with  70–72

New Windows tool  29
non-breaking hyphens

formatting  356
how to insert  227

non-breaking spaces, inserting  227
Normal Style, understanding and modifying  

408
numbers

legal style  377
number forms  217
number spacing  217
page number style and placement  230

O

objects
aligning  553
Browse Object feature  252
distributing vs. aligning  555
embedded

linking vs. embedding  583
saving to previous version of Word  51

grouping and ungrouping  555
inserting

existing objects, adding  585
new object, creating  584
Object dialog box  584
placing, procedures for  207
positions, choosing  556

layering, controlling  556
OLE (Object Linking and Embedding)  

technology  583
text wrapping, controlling  557
wrap points, adding and editing  558

Office 2010 and themes  127
Office.com

checking  839
Templates area  71
themes, downloading  130

Office Communicator, co-authors online  43
Office Online, additional templates  71
OneNote notebooks, reusing content in  203

Open Document format  206
opening files

in Backstage view  34
Open And Repair  77
Open dialog box  76
in Protected View  67
related files, opening  44

OpenType fonts
how to use  216
saving to previous version of Word  51

operators symbol set  564
Organizer, the

modules, working with  833
templates, modifying  123

orientation of documents, changing  147, 441
orphan/widow control  353
outlines

basics of good outlines  414
changing

cutting and pasting  430
dragging to new location  430
expanding and collapsing the outline  429
moving topics up and down  429

complex projects, reasons to make an  
outline  415–417

exploring outlining tools  419
headings

adding  426
outline levels, applying  426
promoting and demoting  426

how to  219, 220
importing, from a text file  427
new, creating  421–423
Outline View

customizing  422
displaying, along with Print Layout View  

428
displaying levels of text  423
first line of text, showing  424
formatting, removing and showing  425
headings, alphabetizing  433
restructuring your document  431
snipping tool and  420
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858	 Outline view, continued

Outline view, continued
symbols in  418
troubleshooting  418, 422
viewing  24, 417
vs. the Navigation Pane  433

printing  431
types of  414

Outlook, Microsoft  771

P

page setup and pagination
basic page setup, options for  139
borders, page and section  158, 597–599
browsing, with the Navigation Pane  25, 249
custom settings

backing up  169
and the Normal template  169
saving as template  155

document types  143
headers and footers

alignment tabs  166
creating  159
deleting  167
editing  163, 165
field codes  167
galleries  163
themes, changing to match fonts and 

colors  163
viewing  162

headlines and  156
line numbers

adding and controlling  170
deleting  171
troubleshooting  171

margins
adjusting, on the ruler  146
aligning content vertically between  157
binding documents, and  147
changing margin settings  145
custom, creating  145
Margins gallery  145, 146

Margins tab  142
measurement units, changing the default  

147
multiple pages, settings for  151
suppressing top and bottom  22
white space, showing  156

multiple pages
settings  150
viewing  28

options for, in the Page Setup dialog box  
142

orientation of documents  147
page breaks, controlling  156, 157, 353, 438
Page Layout tab

building blocks  230
Themes group and gallery  87

page numbers
adding  159
style and placement  230

page ranges, specifying in indexes  722
Page Setup dialog box  140
paper size and source

Document Grid  149
paper size, choosing  148, 441
paper source, selecting  149

planning your document  140, 142–144
sections, document

borders, adding  600
and columns  191
creating  153–155
headers and footers, removing and editing  

168
section types  154
when not to use  152
when to use  151

setup defaults, saving to the current  
template  168

text wrapping breaks, inserting  155
paragraph formatting

aligning and indenting text
Drawing Grid, overriding  341
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first line and hanging indents  341
left and right indents, adjusting  340
Paragraph Dialog box, using  341
tools and shortcuts for  338
using the ruler  339

AutoFormat feature
adding to the Ribbon  338
as you type  335
choices, adjusting  336
managing  334
options, changing  336

borders, adding  600
building blocks  235
Document Defaults  407
drop caps, creating  357
formatting markers, viewing

Reveal Formatting pane  402
Show/Hide button  333

hyphenation
automatic  355
manually  356
options for  354
text in other languages  355

line and page breaks, controlling  353
linked styles  382
paragraph styles  382
parameters of  333
spacing issues

addressing  343
empty paragraph marks, cleaning up  344
line spacing, specifying  345
space above and below paragraphs, adjusting  

346, 442
Style Inspector  401
Styles and  334
tabs

carrying from one paragraph to the next  
350

default Normal template  348
manual, clearing  352
role of  347
setting, using the Tabs Dialog box  351
setting with the Ruler  349

shifting text, and  348
tab and indent types  350

understanding  332
parental controls, how to set up  68
passwords

encryption  48
file-sharing  125
macros, protection for  835

pasting content
Ignoring paste options  82
paste options  81
Paste With Live Preview  82, 83

patterns for backgrounds  182
PC and Mac compatibility  39
PDF files

saving documents as  627
and secure sharing  658
understanding  626

permissions
Add A Digital Signature  48
for co-authors  43
content controls, locking  803
customizing  637
Encrypt With Password  48
Mark As Final  48
Restrict Editing  48
Restrict Permission By People  48
setting  48–50, 636
user permissions, setting from the Info tab  

35
Windows rights management  125

personal information, removing from  
documents  625

photos
for backgrounds  182
editing and adjusting  534
improvements and enhancements for  9

pictures
arrangement on page

aligning objects  553
distributing vs. aligning  555
grouping and ungrouping objects  555
object layering, controlling  556
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pictures, continued
Position tool  556
text wrapping, controlling  557
wrap points, adding and editing  558

for bullets  367
Clip Art task pane  164
editing

artistic effects, applying  532
backgrounds, removing  539
cropping  535
image adjustment  534
resizing  537
rotating  538

enhancing
captions, adding  543
picture borders  542, 600
picture effects  543
pictures styles, applying  541

inserting
borders  604
screenshots and clippings  553

macro to toggle Show Picture Placeholders  
828

obtaining, using the Snipping Tool  420
as page backgrounds  537
Picture content controls  797
Picture dialog box, opening  164
Picture Effects, adding  542
shapes and lines

shadows and 3-D effects  549
shape fills, changing  546
shape styles, applying  545
shape text, adding and formatting  546
transparency  548
vs. pictures  544

watermarks as  185
pie charts  500
placeholders for citations and sources  318
Plain Text content controls  796
points (unit of measure)  214
postal codes, formatting  776
power outages, and recovering unsaved files  

54

printing
cancelling a print job  446
envelopes  785–787
greener printing  435
images, color or black and white  551
labels  787
merge documents  783, 785–787
options, setting

backgrounds, printing  179, 183
copies, number of  447
document elements  450
document orientation, changing  441
margins, adjusting  441
odd and even pages  449
page numbers, formatted vs. physical  449
printing ranges  448
printing several pages per sheet  452
Print tab in Backstage view  35
scaling printed documents  453
semi-transparent option  186

paper size, changing  441
paper source, selecting  149
previewing your document

importance of  438
making changes while previewing  441
Print and Preview tools  57, 439
zooming in on details  439

Print Layout View
changing to a different printer  437
default view  22
displaying, along with Outline View  428

Print tab in Backstage view
preview and page through documents  37, 

57
productivity features  436
setting options for  35

.prn files  448
specialized printing

envelopes  456–458
labels  458
options available  454–456

tables, printing without row and column 
lines  487
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text
“fitting” text  442
hidden text  445
selected text  444

Tracked Changes lists, printing  445
troubleshooting

borders  603
characters cut off  454
extra blank pages  445
fonts, wrong  446
markup lists, non-functioning  452
two-sided printing, and paper jams  450

priority for e-mail messages, setting  659
product ID, how to locate  37
proofing options

complex documents  175
display and exceptions, controlling  296–298
flagged errors, fixing  292–294, 294–296
how to change  63
proofing notifications

flagged errors, fixing  292
jumping to the next  294
types and descriptions of  292–294

Proofing Status display  291
proofreaders, necessity of  294, 297
setting a language  270
Spelling and Grammar dialog box  294
spelling and grammar options, configuring  

298–301
suppressing proofing marks  294, 296

Protected View  67
protection of documents

digital signatures and stamps
adding a stamp  631
attaching to files  630
certificate authorities and security adminis-

trators, working with  629
digital IDs, creating  629
digital IDs, how to get  628
removing signatures  632
signing  628
viewing signatures  631

editing restrictions, applying  622–624

encryption
how to  620
passwords  620
removing protection  621

features in Word 2010  614
forms, working with  805–807
hidden data, removing  625
macros

Macro Security settings  814
passwords, assigning  835

Mark As Final feature  618
PDF and XPS files, preparing  626
personal information, removing  625
preparing files for  47–49
privacy options  635
Protected View

choosing what is displayed in  616
file validation, changing  617
working with  615, 635

Protect group on the Developer tab  791
security warnings, checking for red X  633
Windows rights management  125

Publishers, Trusted
adding to list  634
specifying  66

Q

Quick Access Toolbar
Alignment Tabs, adding to toolbar  166
custom galleries and AutoText galleries  242
display

location  17
resetting default  16

function and customization of  16, 63
macros  818–820, 831
Mini Translator, adding  277
opening documents  76
Open Recent File, adding  56
Print Preview and Print, adding  439
Quick Print, adding  443
Redo button, adding  86
Styles Combo Box, adding  391
templates, access to  117
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Quick Parts
building blocks  230
headers and footers  164

Quick Styles
designs available  384
Quick Style gallery

Apply Styles Pane  390
create new style  397
Modify a style  397
Select All # Instances of Style Name  394
styles, applying and modifying  385–387

QuickStyles folder, location of  389
resetting  389
SmartArt diagrams  498
themes and  129
understanding  102, 384

Quick Style Sets
about  211
custom, creating  387–389
custom, deleting  389
resetting  389
switching and modifying  386
themes and  387, 388

Quick Tables
adding a table  465
Quick Tables gallery  233, 466

R

radar charts  500
readability level of documents  306
read-only files

permission  48
templates, suggested for  125

receipt requests, for e-mails  660
Recent Documents

Quick Access Toolbar, adding to  56
Recent tab in Backstage view

file status, changing  75
locating  34, 75
options for  35, 55, 76
pinning a document to the list  75

recovery, document
draft versions of  52–54

unsaved files  54
Redo or Repeat, how to use  86
red X on documents, meaning of  633
references

bibliographies
description of  314
generating  319
style, choosing  315

citations
description of  314
editing  318
inserting  317
placeholders, adding and using  318
Track Changes, using  318

cross-references
adding  326
deleting  328
error messages  328
as hyperlinks, for web pages  327
modifying, moving, and updating  327
relative  328

footnotes and endnotes
customizing  321
deleting  323
description of  314, 320
inserting  321
margins and  325
moving and copying  323
separator lines, creating new  324
views, and visibility of  322
on web pages  323

Reference tab
building blocks  230
groups and types of references  313

sources
adding and managing  315
description of  314
editing  318
other source lists, incorporating  317
placeholders, adding and using  318

types of  312
reflection options for text, applying  219
Related Files area of the Info tab  44
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reports
building block ideas for  241
page setup features  143

resizing pictures  537
reusing content

how to features  203
ideas for  204
understanding  202

Reveal Formatting Task Pane  401
Reverse Book Fold page settings  151
review process

balloon and Review Pane options, configuring  
680–683

comments and revisions, viewing  673
confidential revisions  696
organization of  667
reviewer name, setting  671
reviewers, configuring colors for  672
versions of documents, how to view  697

Ribbon, the
AutoFormat, adding  338
custom galleries and  241
customization of  5, 63, 64
Developer tab, attaching templates  118
dialog launchers, access to  17
disappearance of  29
display and minimization of  15
features of  14
galleries on  19
macros, adding to  818
new features in  5
Outlining tools, viewing  419
Page Layout tab  140
purpose of  33
Quick Access Toolbar and  17
Quick Styles button  384
resetting  65

Rich Text content controls  796
right alignment of text  224
rotating pictures  538
rulers and gridlines, displaying and hiding  26
Ruler, the

aligning paragraphs  339
setting tabs  349

S

Safe Mode, starting Word in  108
sales reports, ideas for  240
saving files

AutoRecover  52
Background Saves  52
changing options for  63
fast command for  34
file types  94
macro-enabled documents and templates  

813
to network locations  655
Save As Dialog Box  92
Save & Send tab  36, 58–60, 93
Save to Web  59
to a server  11
in SharePoint Workspaces  650
to a SharePoint Site  94
simple save  91
to Windows Live SkyDrive  653

scaling printed documents  453
Scatter (XY) charts  500
screenshots

adding  553
Screenshot feature  10

ScreenTips
displaying in a different language  268
setting preferences for  64

scripts symbol set  564
scrolling, synchronous  30
search function

based on tag and comment information  40
Browse Objects feature  26
Search Document box  25, 251
text search using the Navigation Pane  26

security administrators, working with  629
sentence case, changing  220
shading

behind content, applying  606
behind table data  485
considerations for using  608
of color effects  181
tables and paragraphs, applying  607
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shadows
adding and controlling  549
coloring shadows  550
position and appearance of, changing  550
shadow settings for text  219, 220

shapes
in charts, formatting  520
Drawing Canvas option  530
Drawing Grid, using  531
shape fills, modifying  547
shape text, adding and formatting  546
styles, applying  545
as text containers  572, 576
transparency  548

SharePoint accounts
co-authoring in

contacting co-authors  700
editing and saving simultaneously  698
setting up and using  697
troubleshooting  701

explanation of  59
reusing content  203
saving to  60, 93, 94, 643
SharePoint blog  755
SharePoint Workspace 2010

documents, checking in and out  649
Groove workspaces  646, 648
new documents, creating  650
new workspaces, creating  646–648

sharing building blocks  237
single spacing, setting  345
size, document  38
small caps  220
SmartArt diagrams

creating  494
formatting, making changes to  497
Quick Styles  498
saving to previous version of Word  51
text, adding and formatting  496

Snap Objects To Grid feature  555
Snipping Tool  420
social media sites, reusing content for  203
software updates  61

sources, referencing
adding and managing  315
description of  314
editing  318
other source lists, incorporating  317
placeholders, adding and using  318

spacing issues
addressing  343
border spacing, adjusting  601
empty paragraph marks, cleaning up  344
line spacing, specifying  345
space above and below paragraphs, adjusting  

346
table cell spacing, changing  479

special characters
inserting  224, 227
locating, using the Find and Replace dialog 

box  257–259
speech recognition

for content creation  77
training Office 2010 to recognize your voice  

77
spelling

AutoCorrect  293
checking, as you type  296
checking, from the Status Bar  30
contextual spelling feature  9, 404
Do Not Check option  297
error notifications  291
hide spelling errors, when to use  296
options, configuring  298–300
other languages  270

Split documents command  29
splitting table cells  478
splitting windows, using the splitter  262
startup options, how to change  63
Status Bar

language and keyboard preferences  31
options, adding or removing  31
Page area  30
spelling and grammar  30
understanding and tailoring  30
word count  30
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stock charts  500
strikethrough of text

double strikethrough  220
Home tab command and keyboard shortcut  

216
styles

aliases, assigning  394
applying

Apply Styles Pane  390, 394
automatically  119
chart styles  511

clearing and deleting  393
comparing formatting  403
and content controls  800
creating and modifying

automatic updating, enabling  399
based on existing styles  398
based on existing text  395
modifying existing styles  397
styles for following paragraphs  399
templates, adding a style to  400

font formatting  223
fundamentals of  381
images, applying picture styles to  541
line styles, for borders  592
management tools

Reveal Formatting pane  401
Style Inspector  401

Manage Styles dialog box
Edit tab  405
Recommend tab  406
Restrict tab  406
Set Defaults tab  407
when to use  404

printing document styles  452
purpose of  379
Reveal Formatting Task Pane  401–403
selecting and changing all instances of  394
shape styles, applying  545
source of, how to locate  404
Style area, how to display  380
Style Inspector  401
Styles Combo box  391, 394

Styles Pane
Clear All option  393
creating new from formatted text  395
Disable Linked Styles  392
display only current document styles  398
Manage Styles  392, 404
Modifying a style  397
New Style  392
Options  393
recommended list of styles  406
Show Preview  392
Style Inspector  392
Styles list  392
working with  390–394

table of contents (TOC) styles  707, 715
table styles  480–483
Text Effects gallery  219
underlining  215
watching as you work  380

subdocuments  206
subscript, text  216
superscript, text  216
surface charts  500
symbols

adding  224
automatic insertion  226
Symbol dialog box  227
types of, in Outline View  418

T

table of authorities
citations, adding manually  734
generating  736

table of contents, building blocks for  230
table of contents (TOC)

creating
customized  708–710
manually adding entries  710
TOC styles  707

customizing
defaults, resetting to  716
entry styles, matching to TOC levels  715
styles, changing  715
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table of contents, continued
Table of Contents Options dialog box  

708–710, 714
formatting

changing the format  712
choosing a format  711
editing and updating  712

headings for, effective  706
necessity of  705
removing a TOC  713
troubleshooting, missing headings  712
for the Web  713

table of figures
captions, adding  732
figure numbering, controlling  733
generating  734

tables
cells

deleting  477
inserting  476
merging  477
selecting  474
spacing and alignment, changing  479
splitting  478

columns and rows
adjusting, after splits and merges  478
deleting  477
distributing data evenly  489
inserting  476
moving  477
widths and heights, changing  489

creating
drawing a table  468
Excel spreadsheets, inserting  470
inserting, and AutoFit Options  467
methods for  464
Quick Tables  465
Row and Column Grid, using  467
size considerations  479
text, converting to a table  469

editing
converting a table to text  470
copying and pasting table data  474
formatting marks, displaying  472

options for  472
selecting table cells  474
selecting table segments  474

formatting
AutoFormat feature  480
borders, custom  484
borders, options for  605
default, setting  483
displaying formatting marks  472
font size, troubleshooting  483
Reveal Formatting pane  402
shading behind data  485
table styles  380, 383, 480
table styles, custom  482–484
Table Styles gallery  392
Table Tools contextual tab  380
themes and  482

functions, working with  490
nested tables  471
planning  464
positioning in documents

flowing text around tables  485
indenting the table  485
options, how to  485
table breaks, controlling  491

printing without row and column lines  487
resizing

AutoFit, testing  488
AutoFit, understanding  487
column width and row height, changing  

489
distributing data evenly  489
entire tables  488
options for  487
preset and percent table sizes, setting  488
text direction, changing  489
view options  488

tabbed vs. borderless  347
table data, sorting  486
and web page design  490

Tablet PCs and handwritten content  204
tabs

carrying from one paragraph to the next  
350
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contextual
Chart Tool tabs  505
purpose of  15

default Normal template  348
Developer tab  790
manual, clearing  352
Options command  36
on the Ribbon

customizing  64
types  14

role of  347
setting

using the Tabs Dialog box  351
with the Ruler  349

shifting text and  348
tab and indent types  350

tagging documents
adding to content controls  800
how to  40
purpose of  39
tips for  39

templates
adding and removing  115
attaching to documents  117–119
boilerplate text for  111
building blocks, built in  231
building blocks, sharing  237
chart templates  503
custom

backing up  107, 169
based on existing document  112, 114, 155
based on existing template  112, 114
design considerations for  113
elements of  114
managing  63
page setups, saving  168
saving  115
from scratch  112, 114
single click access to  117
testing  116

Custom XML feature  104
design, consistent  72
existing

changing the template file  122

changing while working in a document  
123

created in previous versions of Word  105
modifying  122
renaming, deleting, and copying styles  

123
global

loading, automatically  120
loading, manually  120
Normal and Building Blocks templates as  

119
troubleshooting  121
unloading  121
working with  119

how they work  105
how to find  70–72, 109–111
macros and  812
for mail merge  766
managing

the Organizer  123
protecting  125
troubleshooting  124

My Templates folder  71, 74
Normal template

adding styles to  400
automatic macros and  824
damaged, replacing  107
default for new documents  383
default settings, changing  169
Quick Style Set as default  389
renaming  107
tab default  348
troubleshooting  106, 108
understanding and using  106–108

Office.com Templates  110
options, summary of  110
previewing  72
purpose and operation of  102–105, 105
Recent Templates  71, 72
Reset To Quick Styles From Template  389
reusing content  203
Sample Templates  71
saving favorites  74
saving keyboard shortcuts in  411
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templates, continued
storage location, changing  106
storing online  111
style change in documents  383
styles, adding to templates  400
Template group on the Developer tab  791
Workgroup Templates  110, 656
XML formatting of  103

text
alignment  223
attributes, applying  215
bidirectional, working with  282
clearing formatting  223
color, changing  222
columns, flowing text into  194
converting to a table  469
entering  203
“fitting” or condensing, methods for  441
formatting of

as you go along  210–212
comparing formats  403
inconsistencies, tracking  404
Style Inspector  401
styles  380, 382

hidden, printing  445
highlighting tool  221
new features for enhancement  10
OpenType fonts, using  216
Rich Text and Plain Text content controls  

796
selecting text, and shortcuts for  79
shape text, adding and formatting  546
size, changing  28
tables

flowing text around  485
text direction, changing  489

Text From File command, to import  
documents  204

Text Highlight tool  212
text size

Keyboard shortcuts for  215
points as unit of measure  214

text watermarks  185
text wrapping breaks, inserting  155
text wrapping, controlling  557
wrap points, adding and editing  558

text boxes
adding  572
building blocks for  230
drawing canvases, creating  580
formatting  574–576
inserting text into  574
linking, to flow text  578–582
saving to previous versions of Word  51
text wrapping  576
when to use  570

text effects
additional formats  220
applying  218
deleting  220
saving to previous versions of Word  51
Text Effects gallery  219
Text Effects tool  218

textures
custom  182
for page backgrounds  182

themes
changing

applying a new theme  130
colors  131
font selection  131
what to be aware of  127

charts and  504
colors and  89
custom

color schemes  135
font sets  136
saving  137

default  129
downloading  130
effects and  90, 133
experimenting with  87
font colors and  223
fonts and  89
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formatting changes and  211
galleries and  130
overriding theme settings  132
purpose of  126
Quick Styles and  129, 384
Quick Style Sets and  387
settings  134
table styles and  482
Theme Fonts  213
what they include  102, 128

thesaurus, function of  290
3-D effects, applying and customizing  551
time and date elements  228
titles

adding to content controls  800
chart titles, adding  512
displayed on the Info tab  39
Title Case, applying  220

toggle commands
text attributes and effects  216
toggle case, applying  220

Track Changes edits
accepting and rejecting changes  689–692
balloon and reviewing pane options  

 680–683
changed lines, customizing appearance of  

680
citations  318
comparing and combining documents  

693–697
description of  668
display options  677
printing lists of  445, 451, 684–686
reviewing tracked changes  685–687
saving to previous version of Word  51
viewing, in the Navigation Pane  250
while you edit  678

translating content
custom translations  274
definitions, real-time  274
documents  274
Microsoft Engkoo  274
Microsoft Research ESL Assistant  274

Mini Translator, using  274–276
overview  268
ScreenTips in a different language  268
selected text  274
translation services

adding new  281
changing and adding  274–277, 280
custom  281
Microsoft Translation  279
WordLingo service  274, 278

translation tools  8, 274, 285
transparency

of color effects  181
shapes  548

trendlines, in charts  515
Trust Center

accessing  63, 633
ActiveX Settings  67
Add-Ins, third party  67
categories in  634
File Block  67
Macro Settings  67
Message Bar  67
parental controls  68
permission levels

applying permissions to documents  638
customizing  637
setting  636

Protected View option  67
setting privacy and protection levels  63, 

66–68
setting up  66
Trusted Documents  67
Trusted Locations  66
Trusted Publishers  66
viewing and removing trusted sources  635

typography, OpenType fonts  216

U

underlining
Home tab command and keyboard shortcut  

216
how to apply  215
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underlining, continued
removing  216
Underline button  215
Underline tool, location of  212

Undoing, Redoing, and Repeating, using  85
units of measure

changing, on the Ruler  340
changing the defaults  147
conversion to points  346

unsaved files, recovering  54
updates, software  61
Uppercase text

changing, using the Change Case command  
220

vs. All Caps Font effect  221
user account options, changing  63

V

VBA (Visual Basic for Applications)
Editor

Comment Text  828
elements of  829
modules and views  830
Procedure List  830
Project Explorer  830
Properties Pane  830
structure of statements  827

and macro creation  812
projects  812
syntax of  826

versions of Word
Compatibility Checker  50
Compatibility Mode  46
free document converter  46
macro-enabled and macro-free files, saving  

813
tips for tags  39

views, document
changing, how to  21
draft view  24
full screen reading view  22
number of pages, locating  38
outline view  24
print layout view  22

View Ruler button  26
View Side By Side documents command  29
View tab

document views, changing  21
Navigation Pane, accessing  24
rulers and gridlines, displaying and hiding  

26
size and number of pages, changing  28

web layout view  23
viruses, protection from  108
voting buttons  662

W

watermarking
adding, to printed documents  183
building block styles  230
custom  184
editing  184
picture watermark  185
text watermark  185
troubleshooting  186
Watermark gallery  183

web pages
cross-references as hyperlinks  327
design, using tables  490
TOCs, preparing for the Web  714
Web Layout document view  23
Word Web App, features of  11

widow/orphan control  353
wildcards, using  255, 256
windows

displaying and arranging  262
document, splitting  262
multiple, switching among  264
New Windows tool  29
side by side viewing  263
Switch Windows tool  29

Windows Live accounts
reusing content  203
signing into or signing up for  59
Windows Live Spaces  755

Windows Live SkyDrive  59, 93
co-authoring in  697–701
saving to a shared space  653
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setting up and using  651
sharing files  652
and the Word Web App  757

Windows rights management  125
Windows Snipping Tool  420
Windows Vista and Windows 7  106
Word 2010 new features

authoring features, improved  7–11
color scheme, setting  64
dialog launchers, using  17
document views, changing  21–24
energy saving features  435
galleries, working with  19
Mini Toolbar  20
multiple documents, working with  28
Navigation Pane  24–26
pages, viewing more than one at a time  28
Protected View  67
Quick Access Toolbar  16
the Ribbon, exploring  14
rulers and gridlines, displaying  26
Status Bar, understanding and tailoring  30
user experience, enhancing  5–7
user interface  13
using Word anywhere  11

Word commands, built-in, viewing  834
word count statistics

shown in the Info tab  38
shown in the Status Bar  30
for text box content  581

Word Mobile 2010, flexibility of  12
Word MVP Site  839
Word Options

automatic backup feature, enabling  53
Background Saves, enabling  52
Editing Options  404
General Program preferences, changing  64
how to change

from Backstage view, tabs column  62
Options link on the Help tab  61

Paste commands, setting default for  83
Recent Documents, how to change number 

of  76

for text selection  79
Word Solution Center  839
Word Startup folder  121, 237
Word Web App

and blogging  757
how to use  757–760
opening documents in  757
using anywhere  757
working with  758

Word Web App, features of  11
workgroup templates, using  656
WorldLingo translation tool  278, 279

X

XML-based formats
Ecma Office Open XML format  103
and macro-enabled files  813
Open Document format  206
reusing content  203

XML data, mapping controls to  804
XML group on the Developer tab  791
XPS files

saving documents as  627
for secure sharing  658
understanding  626

XY (Scatter) charts  500

Z

Zoom dialog box
document display options  28
document navigation in  261
options in  441

Zoom tools
in Draft and Outline views  440
modifying Zoom levels, creating a macro for  

824
on Print Preview tab or View tab  439
Zoom slider, and document display  21

MSWord_IO.indb   871 9/21/10   3:13 PM



MSWord_IO.indb   872 9/21/10   3:13 PM



About the Author
Katherine Murray wrote her first book about Microsoft Word back in the dark ages when it 
was only available in a DOS version (remember that?). Over the years, Word has been her 
favorite program, and she’s seen it grow from a mind-blowing word processing program 
(that actually shows line breaks on the screen!) to a full-featured, complex (and overweight, 
some might say) program that does everything you could ever want a word processor to 
do, including sewing a button on your shirt. Finally she’s seen Word mature into an elegant, 
smart, efficient program that provides the flexibility to produce content for a variety of 
platforms, graphic design tools to help even art-challenged writers look good, and enough 
high-end features that proficient users can streamline their tasks and produce smart con-
tent that hits the mark but doesn’t gobble up their creative time.

Katherine writes about all sorts of Microsoft Office technologies, and, true to what she 
writes about, she outputs the content she writes through multiple channels: As books, 
e-books, presentations, video demonstrations, articles (for CNET’s TechRepublic and Micro-
soft.com), and online learning courses with Microsoft Learning. She also blogs regularly (her 
Office blog is called, appropriately, BlogOffice) and loves gardening, cooking, and doing 
just about anything under the sun with her kids, grandkids, and animals.
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Stay in touch!
To subscribe to the Microsoft Press® Book Connection Newsletter—for news on upcoming 
books, events, and special offers—please visit: 

What do  
you think of  
this book?
We want to hear from you! 

To participate in a brief online survey, please visit: 

Tell us how well this book meets your needs—what works effectively, and what we can  
do better. Your feedback will help us continually improve our books and learning 
resources for you.   

Thank you in advance for your input!

microsoft.com/learning/booksurvey 

microsoft.com/learning/books/newsletter 
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